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Abstract 

 
Extraction of good quality DNA from soil samples is difficult due to the co-extraction of 

humic acid and phenolic compounds which can inhibit downstream DNA profiling of 

samples. Several methods are available for DNA extraction from soil including a number of 

commercially available kits. We used varying amounts (5 mg to 250 mg) of soil contaminated 

with human body fluid (saliva, semen and blood) to compare commercial kits (Powersoil® 

and PrepFiler™), a standard  phenol/chloroform extraction method, and a method employing 

superparamagnetic iron oxide nanoparticles (SPIONs) generated in-house. Extraction success 

and level of purity  of the human DNA extracted using these  methods were assessed by 

quantifying the amount of DNA recovered using a Nanodrop 2000 and the amount of humic 

acid recovered using UV-Vis spectroscopy. Furthermore, successful human DNA profiling 

was assessed using an in-house generated four-plex PCR assay amplifying fragments of 70 

bp, 194 bp, 305 bp and 384 bp, as well as the commercial Powerplex® 16 DNA profiling kit 

amplifying 16 different amplicons. Our results indicate that the PrepFiler™ kit and 

phenol/chloroform whilst successful at extracting DNA, contained very high levels of humic 

acid in the extracted DNA greatly impairing DNA profiling even after dilution of DNA (1 in 

10) and addition of higher amounts of Taq (5U).  The PowerSoil® kit in contrast, performed 

best by recovering the most DNA whilst removing the most humic acid, and good quality 

DNA profiles were obtained without the requirement for dilution of the DNA or addition of 

extra Taq. However, using extensive optimisation procedures using SPIONs, we have 

developed a protocol that is able to achieve results very similar to those achieved using 

Powersoil®, thereby greatly reducing the cost per sample. 
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1. Introduction  
 

1.1.  A brief history of forensic DNA analysis 

 

Forensic science aims to help judges and juries in solving legal issues, not only in criminal but 

also in civil cases. The main aspects of forensic science are the identification, 

individualisation and classification of physical evidence found at a crime scene.   

The ultimate goal of forensic science, in the identification process, is individualisation which 

gives information on the origin of a particular piece of evidence. For many years only few 

types of evidence, such as fingerprints, could be unequivocally individualized. All other types 

of evidence could only be said to be consistent with originating from a particular location or 

individual. However, in 1980s, one particular biological tool revolutionised forensic 

investigation – DNA analysis. 

 

Any type of organism can be identified by examination of its DNA sequences which is unique 

to that organism. Every cell carries a copy of the DNA and, all DNA exhibits variability both 

among and between species; therefore, any biological material associated with a legal case 

carries information about its source that can be used to distinguish between individuals since 

the order of base pairs in the DNA of every individual is different except in identical twins. 

 

Forensic DNA analysis has greatly evolved since it was first used over 30 years ago and has 

become an indispensable and routine part of forensic casework. Employing extremely 

sensitive PCR-based techniques to analyse biological material has enabled forensic scientists 

to link suspects to crime scenes or one crime scene to another using biological evidence left 

behind in form of saliva, hair, skin cells or various body fluids.  
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The aim of forensic DNA analysis is to identify with as much certainty as possible the origin 

of particular evidence. Many databases, tests and techniques that are currently being widely 

and routinely used in forensic investigations have been developed and refined in a process 

which, for some disciplines, had taken centuries and for more recent technologies, decades.  

 

The concept of using DNA as a method of individualisation emerged in 1985 when Alec 

Jeffreys discovered a significant variation between individuals in particular regions of DNA 

(Gill et al. 1985, Jeffreys Alec J. et al. 1985a, Jeffreys A. J. et al. 1985b). Jeffreys found that 

certain regions of DNA contained a very characteristic pattern of short sequences repeated in 

a tandem fashion. He also discovered that the number of repeats could vary between 

individuals (and within for heterozygous loci) - these regions of DNA became known as 

Variable Number Tandem Repeats (VNTR) or Minisatellites. Upon analysis using Southern 

blotting, the unique patterns of the polymorphic regions in an individual and similarities in 

principle to fingerprinting methods for identification resulted in the use of the term DNA 

fingerprinting (Jeffreys et al. 1992). 

 

Despite the fact that using minisatellites resulted in successful individualisation, the technique 

was time consuming and laborious and more importantly, required large amounts of well-

preserved DNA which usually is almost impossible to acquire from forensic samples. Due to 

these limitations, DNA fingerprinting was subsequently replaced by STR DNA profiling. 

Short tandem repeats (STRs) or microsatellites are relatively short (100 bp to 350 bp) regions 

which consist of tandemly repeating units of 2-6 bp  that can be repeated many times within a 

particular locus (Queller et al. 1993).  
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The microsatellites in use today for human DNA profiling are all tetra- or penta-nucleotide 

repeats  because dinucleotide repeats  tend to suffer from artifacts such as PCR stutter (Butler 

2005). 

 

The very first widely used multiplex consisted of 4 STRs (quadruplex) (Kimpton et al. 1993). 

However, due to its very high match probability (1 in 10000), the first criminal case involving 

STRs was done in conjunction with single-locus probe (SLP) DNA fingerprinting  (Jobling 

and Gill 2004). Subsequent addition of two more highly variable STRs reduced the match 

probability to 1 in 50 million, and this multiplex was then named “second-generation 

multiplex” (SGM). This multiplex also included the amelogenin marker thereby revealing the 

sex of a sample donor.  

In 2000, an additional 4 loci were added to this multiplex, which was renamed SGM Plus, 

further reducing the match probability to 1 in 10
13 

(Cotton et al. 2000). 

The ability to study multiple STR markers in parallel using multicolour fluorescence                      

detection technologies has revolutionized STR DNA profiling, allowing large numbers of loci 

to be analysed simultaneously, giving very high levels of discrimination between individuals. 

Many different commercial STR multiplex kits are currently available (Table 1.) and the 

AmpFlSTR GlobalFiler kit (Applied Biosystems) can simultaneously amplify 24 different 

STR loci including amelogenin and Y-indel. Another commonly used, in forensic human 

DNA analysis, STR multiplex, PowerPlex®16 (Promega), uses four dye colours system to 

amplify and detect 16 different DNA targets. PowerPlex®16 is highly optimized and robust 

with an easy to follow protocol (PowerPlex®16 Manual, Promega). A complete profile can be 

generated within four hours after the DNA extraction procedure.   
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Multiplexes are analyzed using automated genetic analysers consisting of multi-channel 

capillary electrophoresis systems that are used to detect fluorescently labeled PCR 

products. As a result of such automation, STRs became ideal for forensic DNA profiling, 

greatly reducing costs and increasing throughput.  

Furthermore, STR typing requires very little template DNA since it is PCR-based. Small 

quantities of poor quality DNA obtained during forensic investigations are often the only 

samples available, making the PCR technique highly useful (Decorte 2010, White et al. 

1989).  

Development of PCR-based DNA profiling not only allowed for the generation of profiles 

from types of samples that had not previously been examined such as cigarette butts 

 SGM 

Plus® 

Profiler 

Plus ® 

Identifiler® PowerPlexFusion PowerPlex® 

16 

PowerPlex® 

21 

AmpFlSTR 

GlobalFiler 

Amelogenin 

D16S359 

D18S51 

D19S433 

D21S11 

D2S1338 

D3S1358 

D8S1179 

FGA  

THO1 

vWA 

Amelogenin 

D13S317 

D18S51 

D21S11 

D3S1358 

D5S818 

D7S820 

D8S1179 

FGA 

vWA 

 

Amelogenin 

CSF1PO 

D13S317 

D16S359 

D18S51 

D19S433 

D21S11 

D2S1338 

D3S1358 

D5S818 

D7S820 

D8S1179 

FGA 

TH01 

TPOX 

vWA 

Amelogenin 

CSF1PO 

D10S1248 

D12S391 

D13S317 

D16S359 

D18S51 

D19S433 

D1S1656 

D21S11 

D22S1045 

D2S1338
 

D2S441 

D3S1358 

D5S818 

D7S820 

D8S1179 

DYS391 

FGA                      

Penta D             

Penta E                      

TH01              

TPOX                

vWA 

Amelogenin 

CSF1PO 

D13S317 

D16S359 

D18S51 

D21S11 

D3S1358 

D5S818 

D7S820 

D8S1179 

FGA 

Penta E 

PentaD 

TH01 

TPOX 

vWA 

 

Amelogenin 

CSF1PO 

D12S391 

D13S317 

D16S359 

D18S51 

D19S433 

D1S1656 

D21S11 

D2S1338 

D3S1358 

D5S818 

D6S1043 

D7S820 

D8S1179 

FGA 

PentaD 

PentaE 

TH01 

TPOX 

vWA 

 

 

 

 

Amelogenin 

CSF1PO 

FGA 

D1S1656 

D12S391 

D2S441 

D10S1248 

D22S1045 

TH01 

TPOX  

vWA 

D3S1358 

D5S818 

D7S820 

D8S1179 

D13S317 

D16S539 

D18S51 

D21S11 

D2S1338 

D19S433 

 SE33 

DYS391 

Y-indel 

Probability 

of identity 
7.04x10

-14 
6.11x10

-12 
6.18x10

-19 
6.58x10

-29 
2.82x10

-19 
6.77x10

-27 
7.73x10

-28
 

Table 1: Current, comercially available STR systems. 
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(Hochmeister et al. 1991), single human hairs (Higuchi et al. 1988), urine (Brinkmann et 

al. 1992), fingernail scrapings (Wiegand et al. 1993) and bite marks (Sweet et al. 1997), it 

also improved the success in generating useful profiles from old, burnt, degraded bone and 

tissue samples (Clayton et al. 1995, Parsons et al. 2007, Whitaker et al. 1995) given small 

STR amplicon sizes. 

 

In cases where the DNA has become so degraded as to preclude STR amplification, a 

different type of genetic marker, single nucleotide polymorphisms (SNPs) is increasingly 

being used. SNPs are DNA sequence variations occuring when a single base pair in the 

genome is altered (Rocha Dominique et al. 2006). Due to its very small amplicon size, 

lower mutation rate in comparison to the STRs as well as abundance in the human genome, 

SNPs are recent markers of interest in the field of forensic science (Budowle and van Daal 

2008, Kim et al. 2010). However, due to  limitations such as lack of widely established 

SNP databases,  and requirment of large multiplexing assays due to the lower power of 

discrimination offered by SNPs given their biallelic nature, SNPs are unlikely to replace 

the currently used STRs in the near future (Jobling and Gill 2004). 
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1.2.  Polymerase Chain Reaction (PCR) and PCR inhibition 

 

The polymerase chain reaction (PCR) discovered in 1983 by Kary Mullis, is now an 

indispensable technique employed by medical and biological research laboratories for a 

variety of applications. While DNA fingerprinting required the input of significant amounts of 

DNA,  PCR based STR profiling requires as little as 0.06 ng of DNA template (Ensenberger 

et al. 2010). 

 

Environmentally challenged biological samples found at a crime scene can produce numerous 

problems in human DNA profiling including allele drop-out, peak imbalance and loss of 

signal (as a result of poor amplification efficiency). 

For many years forensic geneticists have looked into  methodological issues associated with 

degraded DNA  (Alaeddini et al. 2010), tissue preservation (Martínez et al. 1994) and  

strategies to repair degraded DNA (Vasan et al. 1996). One less explored topic is the co-

extraction of PCR inhibitors along with DNA. 

PCR inhibition is the most common cause of PCR failure when sufficient amount of DNA 

template is present in the reaction. While the co-existence of PCR inhibitors is well known 

and a number of methods to improve PCR amplification have already been developed 

(Bourke et al. 1999, Moreira 1998, Yang et al. 1998) (Table 2), the mechanism of the 

inhibition is often unclear.  

According to studies by (Huggett et al. 2008, Opel et al. 2010), co-purified PCR inhibitors 

affect different PCR products differently. Opel et al. (2010) found that primers with higher 

melting temperature were usually less affected by inhibition. This suggested that the 

amplicon/primer sequence may have a direct effect on PCR inhibition, where- primers with 

higher melting temperature due to their  strong binding to the DNA template  may prevent the 

binding of inhibitors (Opel et al. 2010).  
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Substrate(s) Inhibitor(s) Mode of inhibition Facilitator(s) Reference 

     

Faeces and plants Bile salts and complex 

polysaccharides 

Interaction with DNA tamplate 

(sequestration of DNA) 

BSA, gp32, sample dilution (Rouhibakhsh et al. 

2008) 

(Radstrom et al. 2004) 

Bones and connective tissues Collagen Binds to DNA template Sample purification, use of less 

sensitive Taq polymerases, addition 

of Mg
2+

 

(Burkhart et al. 2002) 

(Opel et al. 2010) 

Bones Calcium ions Competitive inhibitor of Mg
2+

 

required for Taq activity 

Sample dilution, chelation,  

addition of Mg
2+

 

(Opel et al. 2010) 

(Bickley et al. 1996) 

Clothing dyes (e.g. indigo) Dyes  Affects DNA template by 

incorporating into DNA structure. 

Sample purification, (Larkin and Harbison 

1999) 

Lactoferrin and 

haemoglobin(Blood) 

Iron ions Competitive inhibitor of Mg
2+

 

required for Taq activity 

Sample dilution, chelation,  

addition of Mg
2+

 

(Radstrom et al. 2004) 

Blood Heme Binds to Taq polymerases causing 

dissociation of the DNA-polymerase 

complex 

BSA, gp32 (Kreader 1996) 

(Akane et al. 1994) 

Hair and skin Melanin Binds to DNA Sample purification, 

Sample dilution 

(Opel et al. 2010) 

(Eckhart et al. 2000) 

Soils and bones Millard Products DNA trapped in complex 

polysaccharide-rich matrix 

(inaccessible to Taq polymerases) 

Sample purification (repeated silica 

extraction) 

(Alaeddini 2012) 

Environmental samples 

containing soil 

Phenolic compounds (e.g. 

humic, fulvic and tannic acids) 

Chelating with  Mg
2+ 

,  

Humic acids have also been reported 

to directly affect Taq polymerases 

and DNA through sequence specific 

binding of DNA, reducing the 

amount of amplifiable template    

Retardation of phenolic migration 

in PVP-containing agarose gel 

electrophoresis, 

Sample dilution, 

Addition of Mg
2+

, 

Ion-exchange chromatography, 

(Mayer and Palmer 1996) 

(Herrick et al. 1993) 

(Tebbe and Vahjen 1993) 

(Tsai and Olson 1992a) 

Semen swabs from sexual 

assaults, 

Microorganisms found in 

environmental samples 

Vaginal microorganisms, 

Non-target DNA 

DNA sequestration, 

Reduction of primer concentration by 

non-specific binding to non-target 

DNA molecules 

Sample dilution, 

Gel filtration, 

(Lienert and Fowler 

1992) 

Urine Urea Denaturation of Taq polymerases Sample dilution, addition of Taq (Abu Al-Soud and 

Radstrom 1998) 

Table 2: Common inhibitory substances and their mode of inhibition encountered during DNA profiling as well as methods of overcoming PCR inhibition. 
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Although the inhibition is thought to be the result of many factors e.g. direct binding of the 

inhibitors to the DNA polymerase; interaction of the inhibitors with the DNA polymerase 

during the primer extension step or binding of the inhibitors to the DNA template, research 

has been mostly focused on the inhibition of the function of the polymerase (Opel et al. 

2010). 

Different inhibitors have different effects on a PCR. Collagen and Ca
2+

 ions are components 

of connective tissue and bone and very often co-extracted during DNA extraction from 

skeletal remains. Although the mode of inhibition differs between those two inhibitors (Opel 

et al. 2010), they both can cause a reduction in PCR efficiency or even PCR failure when the 

concentration of the inhibitors is too great (>8 µg) to be overcome by the polymerase activity. 

In addition, like all Taq inhibitors, Ca
2+

 and collagen affect the PCR efficiency equally, 

regardless of the length of amplicons or the melting temperature of primers used (Opel et al. 

2010).  

Melanin is a pigment found in skin and hair, and is a possible inhibitor present in telogen hair 

samples (Yoshii et al. 1993). Unlike collagen, melanin affects PCR by binding to the DNA 

template therefore having a greater effect on larger amplicons. Opel et al. (2010) found that 

the presence of melanin in the PCR had no or a very small effect on 100 bp amplicons 

whereas complete loss of signal was observed with amplicons longer than 400 bp. 
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In addition, a higher concentration (4 µg/mL) of the inhibitor was required to significantly 

reduce the PCR efficiency with the primer sets with higher Tm. 

 

However, not all inhibitory substances encountered during forensic case work exhibit a such 

straight forward mode of inhibition.  

Humic substances (HS) are very well known and documented cause of PCR failure in forensic 

and microbial studies.     

HS can be subdivided into three main subgroups: Humus, Humic (HA) and Fulvic (FA) acids 

where HA comprise one of the major fractions of humic substances (Saulnier and Andremont 

1992). 

Humic substances are amorphous, dark-coloured and highly stable organic macromolecules 

(Figure 1) found in soils and produced during decay processes through the Maillard reaction 

(Rocha Julio Cesar et al. 1998). Depending on the type of soil, humic substances can make up 

5.0-7.63 µg/mg of soil (Tebbe and Vahjen 1993) and approximately 700-3300 µg/mL of 

humic and humic-like compounds (e.g. fulvic acid) can be recovered during DNA extraction 

from soil samples (Alaeddini 2012). 

Figure 1: Example of a typical humic acid molecule containing a variaty of different functional groups such as carboxyl and 

phenolic groups. Structure of humic acids molecules can vary and often involves crosslinking with sugars and peptides. 
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Due to the charge to mass ratio, their structural heterogeneity, high molecular weight and their 

similarities to DNA, humic compounds feature the most problematic impurity in DNA 

extraction procedures (Zipper et al. 2003).  

HAs have physiochemical properties similar to those of the phosphate groups in the DNA 

backbone (Dong et al. 2006). The high number of hydroxyl and carboxyl groups gives the 

HAs a negative charge similar to DNA which therefore can compete with DNA for the 

binding sites during purification steps (silica based DNA extraction) (Roose-Amsaleg et al. 

2001). HAs are thought to chelate the magnesium ions required for the Taq polymerase 

activity (Tsai and Olson 1992a). It has also been reported that free DNA in soil rapidly 

adsorbs and binds HAs (Crecchio and Stotzky 1998, Tsai and Olson 1992b) which provides 

protection against nucleases (Alvarez et al. 1998) but entraps the DNA making it inaccessible 

to the Taq polymerase. Furthermore, it has been reported that,  like all other oligomeric 

compounds with free phenolic groups (e.g. tannins), HAs can covalently bind to and 

inactivate polymerases (Young et al. 1993). 

As little as 0.08 µg/mL of HA has been found to be sufficient to inhibit PCR amplification 

and 0.5 µg/mL will inhibit restriction enzymes (Tebbe and Vahjen 1993) where the level of 

inhibition caused by the HAs is directly associated with the amount of the inhibitor present in 

a PCR reaction. In a different study complete inhibition of certain PCR reactions has been 

shown to occur with 0.05 µg/mL of HA (Tien et al. 1999).  

Studies on inhibition from HAs and melanin indicated a sequence specific manner of PCR 

inhibition through binding to and inactivating a portion of available DNA template (Opel et 

al. 2010). However, the exact mode of inhibition is unclear since different studies suggest 

either Taq polymerases or DNA templates to be the targets for binding (Table 2). 
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1.3.  Overcoming PCR inhibition 

 

Procedures that overcome PCR inhibition need to be developed if PCR is to be successfully 

used for the analysis of environmental samples. Following DNA extraction and detection of 

PCR inhibition, some laboratories employ routine inhibitor trouble-shooting strategies such 

as: sample dilution (Alonso et al. 2001), use of BSA or 32 T4 protein (Oikarinen et al. 2009), 

heat soaked PCR (Ruano et al. 1992), hot start PCR (Kermekchiev et al. 2003) and addition 

of extra polymerase enzymes (Eilert and Foran 2009).  

 

1.3.1. Sample dilution 

 

The most common technique used to overcome PCR inhibition is diluting the DNA extract 

sufficiently to eliminate the inhibition (Imaizumi et al. 2005). However, this technique 

although effective especially in case of mtDNA or microbial DNA analysis where high copy 

number DNA is available, may not be the best choice in case of highly degraded DNA 

templates where the copy number is usually already very low (Taberlet et al. 1996).  

  

1.3.2. Amplification facilitators 

 

The addition of PCR facilitators has been found to improve the specificity of PCR (Jensen et 

al. 2010, Sarkar et al. 1990, Wu and Yeh 1973) (Table 2).  

The possible mode of action of protein-based facilitators such as bovine serum albumin 

(BSA) or single stranded DNA binding T4 gene 32 protein (gp32) (Kreader 1996), is thought 

to lie in their capacity to bind certain inhibitors and therefore inactivate them (Abu Al-Soud 

and Radstrom 2000). 
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With increased concentration of the facilitators, the number of free inhibitors present in the 

reaction will be lowered and therefore indirectly increase the PCR efficiency. In addition, 

BSA cannot relieve inhibition caused by agents interacting with the DNA template only, such 

as collagen (Alaeddini 2012).  

Betaine has been suggested to increase PCR specificity and product yield (Jensen et al. 2010) 

as well as the thermal stability of proteins (Santoro et al. 1992). Due to both positive and 

negative charges present on the betaine molecules at pH close to neutral, the PCR facilitator 

activity has been suggested to lie in its ability to destabilize GC-rich DNA sequences (Rees et 

al. 1993).   

The presence of polysaccharides in a DNA preparation can inhibit PCR. Cetyltrimethyl 

ammonium bromide (CTAB) is a surfactant useful for isolation of DNA from tissues 

containing high amounts of polysaccharides. Under the high-salt conditions the CTAB binds 

the polysaccharides, removing them from the solution (Alaeddini 2012). 
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1.3.3. Addition of higher amounts/use of different types of polymerases 

 

The addition of extra polymerase enzyme may overcome inhibition caused by inhibitors 

targeting that particular enzyme. However, increased concentration of polymerase may result 

in higher frequency of non-specific amplification as well as greatly raise the cost of each 

amplification reaction (Abu Al-Soud and Radstrom 2000).  

Different polymerase enzymes exhibit different properties in regards to their sensitivity to 

inhibitors. Hot-start enzymes such as Ex Taq HS, have been found to be resistant to a much 

higher concentration of inhibitors (such as calcium ions or collagen) from skeletal remains 

(Eilert and Foran 2009). Some DNA polymerases (e.g. Pfu, Act-X-Short) have also been 

found to display greater tolerance to different inhibitors including HA molecules (Eilert and 

Foran 2009).  Genetically modified polymerases (e.g. Klentaq 1) have shown to be highly 

resistant to high concentration of variety of inhibitors (Kermekchiev et al. 2009) but other 

studies have suggested that the enzyme that is least affected by inhibition coming from HAs is 

the Pfu DNA polymerase (Matheson et al. 2010).  
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1.4.  DNA Extraction from soil 

 

Soils are very complex and heterogenous matrices, composed of minerals, and organic matter, 

differing in texture, colour, structure and chemical and biological composition (Mitchell and 

Soga 1976). Depending on the size of soil particles, soils can be divided into three main soil 

types: sands, silts and clay. However, in nature, soils usually occur as a mixture of the three 

(loams), where the contribution of each type varies (e.g. silty-loams – mainly silt with lower 

amounts of clay and sand). Among the mentioned soil types, clay has the highest organic 

matter content followed by silts and sands. Sands are usually very low in organic matter due 

to the lack of suffcient waterlogging allowing plant growth. Furthermore, silty type of soils 

(silty-loams) are the most commonly used in agriculture and gardening since their 

waterlogginng and nutrients capacity is optimal for a wide range of different plants (Mitchell 

and Soga 1976). In addition, unlike clay, silty-loams shows much faster rate of organic matter 

decomposition resulting in much higher nutrients availability as opposted to clays or sands 

making them ideal for agriculturing (Donahue et al. 1977).      

 

The quality of DNA extracted is of utmost importance as the goal is to obtain a reliable STR 

profile. Therefore, extraction methods that enable forensic analysts to isolate DNA from 

samples that contain small quantities of biological material, obtain DNA at a high 

concentration so that the volume of extract used for PCR is minimal and remove all possible 

PCR inhibitors or substances that could potentially interfere with the amplification are highly 

desirable.  

 

Extraction of good quality DNA from soil is particularly difficult due to the co-extraction of 

HA and phenolic compounds which inhibit PCR (Alaeddini 2012, Hudlow et al. 2008, Zahra 

et al. 2011).  
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Isolation of DNA involves cell lysis and DNA purification steps to remove unwanted cellular 

material and other substances such as inhibitors present in the lysate while recovering high 

quality DNA. A variety of lysis methods are available including physical disruption, chemical 

lysis and enzymatic lysis. Freeze-thawing and bead beating methods of physical disruption are 

most commonly used as they yield the largest amounts of DNA (Delmont et al. 2011). 

However the major drawbacks of these techniques are that large concentrations of humic 

compounds are also recovered and shearing of DNA molecules may occur (Simonet et al. 

1991). Chemical lysis procedures vary but usually include mixtures containing detergent (e.g. 

sodium dodecyl sulphate) in the presence of NaCl and buffers such as Tris or phosphate as 

well as chelating agents such as EDTA to inhibit nucleases and disperse soil particles 

(Moreau et al. 1999). Enzymatic lysis using various enzymes such as proteinase K, protease 

or lysozyme that promote cell lysis and digest proteins bound to DNA molecules is also used. 

For samples containing large amounts of inhibitory substances, PVP containing agarose gel  

 

 

DNA extraction kit 

Recommended 

sample amount 

[mg] Cell lysis DNA binding Ref. 

PowerSoil® 250 Bead-beating Silica spin columns 

(Makhalanyane 

et al. 2013) 

PrepFiler™ Forensic DNA 

isolation kit 50 Chemical lysis Magnetic beads 

(Brevnov et al. 

2009) 

Phenol/Chloroform organic 

DNA extraction Up to 5000 Chemical lysis 

Ethanol 

precipitation 

(Steffan et al. 

1988) 

QIAamp Stool 220 Chemical lysis Silica spin columns 

(Jain et al. 

2012) 

UltraClean® 250-1000 Bead-Beating Silica spin columns 

(Claassen et al. 

2013) 

Table 3: Current comercially available DNA isolation kits. 
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electrophoresis, Sephadex G-200 chromatography, PEG two-phase extraction have been used 

as an additional step of DNA extraction in order to separate DNA from PCR inhibitor 

(Rahimpour et al. 2006). 

 

More recently a number of different DNA extraction kits have been developed for isolation of 

DNA from problematic samples such as soils or feaces (Table 3). However, the main 

principle behind the DNA isolation procedure (i.e. removal of inhibitors) using currently 

available commercial kits and older purification techniques such as Phenol/Chloroform, has 

not changed. 

Most commercial DNA extraction kits and published protocols utilise detergent to lyse cells 

as the initial step of DNA isolation. Second, to eliminate contaminating RNA and proteins, 

RNase and Proteinase K are added. In addition, some more sofisticated commercial kits use 

silica matrices or magnetic beads to avoid exposure to organic solvents such as chloroform 

(Table 3). Other methods selectively purify DNA from cellular debris by high salt 

concentration and ethanol precipitation followed by several 70 % ethanol washes. 

By combining the DNA isolation and purification into one simple procedure, DNA extraction 

kits are generally much faster than the organic Phenol/Chloroform method especially in case 

of samples containing high amounts of inhibitors that are chemically similar to DNA 

inhibitors where the simple organic method fails to separate the two and usually require 

additional steps such as PVP-agarose gel electrophoresis or size-exchange chromatography. 

However, most of the comercial kits available on the market rely on silica filter columns 

which involves a number of centrifugation and sample re-pipeting steps that are time-

consuming, not suitable for automation and could potentially be the cause of contamination.   
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1.5.  Superparamagnetic Iron Oxide Nanoparticles (SPIONs) 

 

The last few years have seen major developments in DNA extraction methods using different 

types of magnetic nanoparticles that can separate DNA from the rest of the lysate e.g. 

superparamagnetic iron oxide nanoparticles (SPIONs) (Berensmeier 2006, Sebastianelli et al. 

2008) . SPIONs have been successfully used to extract DNA from soil  (Sebastianelli et al. 

2008) and commercial kits using SPIONs have been developed for use with soil (e.g. 

PrepFiler
TM

) (Brevnov et al. 2009). 

In Sebastianelli et al.’s study, three DNA isolation methods were compared for soil samples– 

Phenol/Chloroform; a commercially available kit SoilMaster
TM

 (Epicentre Biotechnologies), 

and SPIONs synthesised in-house. Their results suggested that SPIONs enabled DNA 

extraction to higher quantities than Phenol/Chloroform and SoilMaster
TM

 methods. The 

SPION extracted DNA also appeared to be of better quality, allowing successful PCR 

amplification of a 566 bp bacterial 16S rDNA product in 3/3 samples, as opposed to 2/3 

samples extracted using SoilMaster
TM

 and 0/3 with Phenol/Chloroform extracted samples 

(suggesting presence of PCR inhibitors since HMW DNA was observed in the extracts). 

However, these experiments were limited in their scope since they relied on the amplification 

of a single product from a high copy number bacterial gene which does not appropriately 

reflect generation of a reliable DNA profile across several loci. Several others have also 

reported successful extraction of microbial DNA from soil (Dineen et al. 2010, Hurt et al. 

2001, Jacobsen and Rasmussen 1992, Whitehouse and Hottel 2007) but because soil contains 

a huge amount of microbial DNA (10
9
 cells/ g of soil - Sebastianelli et al. 2008), the purified 

DNA had to be first diluted in order to optimise the template concentration for PCR. 

However, such a practice also reduces the concentration of potential PCR inhibitors allowing 
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successful amplification. In addition, sample dilution might not be a suitable option when 

dealing with highly degraded or very low amounts of starting material.  

  

Magnetic separation of nucleic acids for purification has several advantages over other 

techniques used for the same purpose- e.g using SPIONs nucleic acids can be extracted 

directly from crude samples including blood, tissue homogenates, water, soils etc. 

Furthermore, due to the possibility of adjusting the magnetic properties of the solid materials, 

the magnetic particles can be removed easily and selectively even from viscous suspensions. 

In fact, magnetic separation is the only feasible method that can be used for recovery of very 

small particles (i.e. silica beads) in the presence of variety of biological debris and other 

materials of similar size.   

In addition, these relatively new separation techniques can also serve as a basis for automated 

low- and high-throughput procedures greatly reducing time and costs of each DNA extraction. 

Furthermore, centrifugation steps and the risk of cross-contamination when using traditional 

methods of DNA isolation can be eliminated.    

 

1.5.1. SPIONs structure and DNA binding mechanism 

 

The increasing use of magnetic particles as a solid phase (carrier) for DNA binding has many 

advantages compared to other non-magnetic separation techniques. The term “magnetic” 

means that the magnetic carrier obtains a magnetic moment when placed in either magnetic or 

electromagnetic field. Thus, it can be displaced regardless of the presence of any other non-

magnetic material. In other words, particles having a magnetic moment can be removed from 

almost any mixture by simply applying a strong enough magnetic field, e.g. by using a 

permanent magnet. It is a quick, simple and very efficient way of separating the particles from  
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the lysate after the DNA binding step (Figure 2) where applying a magnet to the side of the 

tube containing the sample is usually sufficient enough for the separation to occur.  

Magnetic carriers with affinity ligands (e.g. DNA probes) or those prepared using a variety of 

polymers with affinity for the target nucleic acid are used in the extraction processes 

(Spanova et al. 2006). Especially suited for this purposes are SPIONs, which do not interact 

with each other in the absence of the magnetic field. Thus, they do not form aggregates which 

would greatly reduce the active surface area for nucleic acid binding.  

Many magnetic particles are commercially available but can also be relatively easily 

synthesized in the laboratory. Although a variety of different magnetic particles, including 

“naked” iron oxide, modified bacterial magnetites (Amagliani et al. 2006), magnetic capture 

hybridization (uses ssDNA probes to bind DNA), gelatin-, PEI/Au- (Sun et al. 2010), silic-

coated magnetic particles (Sebastianelli et al. 2008) has been developed, and the basic 

structure and binding mechanism is shared among them.  

SPIONs are produced in a two-step process involving Fe3O4 synthesis (reaction carried out 

using FeCl3 ◦ 6H2O and FeCl2 ◦ 4H2O under stream of nitrogen at 25 °C followed by addition 

of urea (25% w/w) and incubation at 80 °C for ~30 min) and silica coating step, where the 

A B C D E 

.  

Figure 2: Schematic procedure for nucleic acid extraction using magnetic beads technology. Upon addition of an 

approprite lysis buffer to a tube containing the sample (A) and carring out the lysis, DNA molecules are released form cells 

into the liquid phase . After the addition of  magnetic beads and an approprite binding buffer, DNA binds to the surface of 

the beads (B). The magnetic particles are then separated from the rest of the lysate by placing it in a magnetic field (C) and 

the supernatant discarded. Figure 2 D and E shows the DNA elution steps where DNA is being released from the surface of 

the beads into the liquid phase upon addition of a salt-free elution buffer. Magnetic field allows separation of the magnetic 

particles from the buffer containing purified DNA molecules (E).   
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synthesized Fe3O4 particles are dispersed in a mixture containing ethanol, deionized water, 

urea and tetraethyl orthosilicate, and incubated at 40 °C for 12 h (Jiang et al. 2012).  

    

The diameter and shape of the particles can vary (~ 0.5-20 µm) (Spanova et al. 2006).  The 

most commonly used magnetic particles for DNA isolation are silica-coated magnetic 

nanoparticles. The structure of silica-coated magnetic particles is shown in Figure 3- each 

particle consists of a magnetisable core (Fe3O4) and a layer of silica coating which carries a 

negative charge when pH is around neutral (Berensmeier 2006). However, since both nucleic 

acids and the surface of the nanoparticles are negatively charged, an addition of chaotropic 

salt, such as NaCl, is required for successful isolation of the target macromolecules. 

Chaotropic salts or specifically the cations present after dissociation of the salt in water, act as 

cross-linkers between nucleic acid molecules and the surface of the magnetic particles (Figure 

3).  

  

 

 

 

 

 

 

Figure 3: Schematic representation of  silica-coated magnetic nanoparticles structure. Negatively charged surface of the magnetic 

particles interacts with sodium cations present in the binding buffer which acts as a crosslinker for DNA binding. 
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1.6.  Aims of the study 

 

The aim of this project was to evaluate four methods of DNA extraction from human body 

fluid contaminated soil samples in terms of the quality of DNA profile produced. The four 

methods were: Phenol/Chloroform extraction, two commercially available kits (PrepFiler
TM 

and PowerSoil®) and magnetic separation using superparamagnetic iron oxide nanoparticles 

(SPIONs) generated in-house. 
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2. Materials and methods 

  

2.1.  Materials 

 

Materials used in this study included: 

 

 

2.1.1.  Samples 

 

a) Human blood 

b) Human saliva 

c) Human semen 

d) Soil  

2.1.2. Consumables 

 

a) 1.5 mL Eppendorf tubes 

b) 15 mL Falcon tubes 

c) 0.2 mL PCR tubes 

d) Tips (10, 100, 200 and 1000) μL and Nishi/Gilson pipettes. 

e) Gloves 

f) Adhesive tape 

g) Universal indicator paper (Sigma, Aldrich, UK) 

 

2.1.3.  General reagents 

  

a) PCR grade water 

b) Distilled, sterile water  

c) Polyvinylpyrrolidone (PVP) (Sigma, Aldrich, UK) 
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d) Humic Acid (Sigma, Aldrich, UK) 

e) 4 M Sodium Chloride (Sigma, Aldrich, UK) 

f) 40% Polyethylene glycol (Sigma, Aldrich, UK) 

g) 1 M Tris-HCl buffer(pH=8.0) 

h) 0.5 M EDTA buffer (pH=8.0) 

i) 10% SDS 

j) Proteinase K (QIAGEN, UK) 

k) 1 M  DTT 

l) Phenol/Chloroform 

m) NaAc 

n) Ethanol (60%, 70%, 96%) 

o) Isopropanol (100%) 

p) SafeView DNA dye (NBS Biologicals ltd., UK) 

q) Agarose (Sigma, Aldrich, UK) 

r) 1x TAE buffer 

s) 6x Loading dye 

 

2.1.4.  PCR reagents 

 

a) AmpliTaqGold Taq ( provided with 25 mM MgCl2 , 10x PCR buffer) 

b) Pfu (recombinant) Taq ( provided with 50 mM (NH3)2SO4, 10x PCR buffer) 

c) Bio-X-Act Short Taq (provided with 25 mM MgCl2 , 10x PCR buffer) 

d) 4-plex STR kit developed in-house (Nazir et al. unpublished ) 

e) Bacterial 16S rDNA primers (F-341 , R-907)  

f) PowerPlex 16 STR kit (Promega, UK) 
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2.1.5.  DNA extraction kits 

 

a) PowerSoil® MoBio Laboratories Inc., CA, USA) 

b) PrepFiler™ Forensic DNA isolation kit, UK (Applied Biosystems, Warrington, UK) 

c) SPIONs (developed in-house) 

 

2.1.6.  Equipment 

 

a) Laminar flow hood (Bioair Instruments, Italy) 

b) CX-2000 UV crosslinker (Fisher Scientific UK Ltd., UK) 

c) Incubators (HYBAID Ltd, Italy)  

d) Centrifuges (GenFuge, Progen, UK) 

e) Magnetic stand (DYNAL MPC®-E, Oslo, Norway) 

f) Gel electrophoresis tanks (RunOne Electrophoresis cell, CA, USA) 

g) UV-transilluminator (BioDoc-it™-Imaging Systems, CA, USA) 

h) Flat-platform shaker (IKA® Works do Brasil Ltd a , RJ)  

i) NanoDrop 2000 (Thermo Scientific, DE, USA) 

j) GeneAmp PCR system 9700 (Applied Biosystems, UK) 

k) ABI 3500 Genetic Analyzer (Genemapper ID-X software)(Applied Biosystems, UK) 

l) Fridges (Biocold, UK) 

m) Freezers (Biocold, UK) 

n) Vortex (Velp Scientifica, Italy) 

o) qPCR  9700 RT-PCR (Applied Biosystems, UK) 
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2.2.  Methods 

 

In this study, 6x 5mL of semen, 1x 10 mL of blood and 1x 3 mL of saliva were collected from 

the student. Saliva and semen were collected into several 1.5 mL Eppendorf and 15 mL 

Falcon tubes, respectively and stored at 4 °C prior to sample preparation. Blood was 

collected, by a qualified phlebotomist, into a single 10 mL tube containing heparin and stored 

at 4 °C.  

Soil samples (composed of silty-loam soils)  were obtained from a local garden (Preston, 

Lancashire, UK) by Dr Arati Iyengar and kept frozen until the sample preparation step was 

carried out.   

 

2.2.1.  Contamination control 

 

Every precaution was taken throughout the study to minimize the risk of sample 

contamination.      

DNA extraction and PCR sample preparation were always carried out in a pre-PCR 

laboratory.  All body fluids and soil samples were kept in separate sealable plastic bags. In 

addition, all DNA extractions and PCR amplifications were performed in triplicate alongside 

negative controls (no body fluid soil control for DNA extractions and no DNA for PCR). 

 

2.2.2.  Sample preparation  

 

Prior to the sample preparation, visual and chemical (pH testing) examination of the soil 

samples was carried out. All samples were prepared by adding 3 mL of liquid saliva, blood or 

semen to a 15 mL Falcon tube containing 3 mg of soil. The body fluid/soil mixture was then 

placed for 24 hours at 4 °C to allow complete saturation of the soil. Blanks (negative controls) 
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were prepared by collecting 50 mg of soil samples prior to addition of the corresponding body 

fluid.  

Body fluid contaminated soil samples of (5, 25, 50, 100, 125 and 250) mg, each in triplicate, 

were weighed out into sterile, labelled 1.5 mL Eppendorf tubes and subjected to a DNA 

extraction procedure. 

2.2.3.  DNA extraction 

 

2.2.3.1. Organic Phenol- Chloroform DNA extraction  

 

Into each tube containing 250 mg of the soil/semen mixture, 460 µL of the X2 lysis buffer 

(Appendix 13), 20 µL of 1 M DTT (Sigma Aldrich) and 20 µL of Proteinase K was added. 

Samples were then briefly vortexed and incubated for 1 hour at 56 °C (vortexing every 15 min 

for 5 sec). 

The lysate was collected and subjected to the Organic Phenol: Chloroform DNA extraction 

procedure (Appendix 6).  

 

2.2.3.2.  PrepFiler™ Forensic DNA isolation kit 

 

DNA extraction procedure was carried out on 50 mg of the soil/semen mixture according to 

the protocol provided with the kit (Appendix 8).  

2.2.3.3.  PowerSoil® MoBio DNA extraction kit 

 

DNA extraction was performed according to the protocol provided with the kit (Appendix 7), 

on a range of soil/body fluid samples containing: (5, 25, 50,100, 125 and 250) mg of the 

mixture. 
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A flat-platform shaker was used to perform the bead-beating procedure. Samples were 

secured and attached to the platform using  adhesive tape.  

(Note: For samples containing blood and saliva, 250 mg of the body fluid/soil mixture alone 

was used.) 

2.2.3.4.  SPION binding based DNA extraction 

 

Into each tube containing (5, 25, 50, 100, 125 and 250) mg of  either the soil/semen or 

soil/blood mixture, 460 µL of the X2 lysis buffer (Appendix13), 20 µL of 1 M DTT (Sigma 

Aldrich) and 20 µL of Proteinase K was added. Samples were then briefly vortexed and 

incubated for 1 hour at 56 °C (vortexing every 15 min for 5 sec). 

The lysate was collected and subjected to the SPION binding based DNA extraction 

procedure (Appendix l). This protocol is henceforth called SPION binding based DNA 

extraction protocol 1 (Appendix 1). 

 

2.2.3.4.1.  Modifications introduced to the SPION binding based extraction protocol 

 

2.2.3.4.1.1.  Modification 1 (SPION binding based DNA extraction protocol 2A) 

 

a) pH and NaCl concentration in the X2 lysis buffer were altered (pH=8.3; 1 M NaCl). 

b) Cold “on ice” precipitation step was added. Following step 3 of the standard SPION 

binding based DNA extraction protocol, all of the supernatant was transferred to a new 

Eppendorf tube. The samples were placed on ice, incubated for 10 min and then 

centrifuged at 13000 rpm for 2 min. The supernatant was transferred to a new tube 

avoiding the pellet. The next steps were as described in the standard protocol. 

Refer to Appendix 1 
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2.2.3.4.1.2.  Modification 2 (SPION binding based DNA extraction protocol 2B) 

 

In addition to modification 1, the following additional modifications were made: 

a) DTT was not used during the lysis step. Step 1 of the standard SPION DNA extraction 

protocol was altered as follows:  

To each tube containing the sample, 480 µL of the X2 lysis buffer and 20 µL of the Proteinase 

K were added and tube incubated at 56 °C for an hour vortexing every 15 min for 5 sec. 

Follow the SPION DNA extraction PROTOCOL 2A (Appendix 2). 

 

2.2.3.4.1.3.  Modification 3 (SPION binding based DNA extraction protocol 3A) 

 

In addition to modification 1, the following additional modifications were made: 

Step 4 of the SPION DNA extraction PROTOCOL 2A was altered. 16% PEG in 4 M NaCl 

was used as the binding buffer (Appendix 2). 

 

2.2.3.4.1.4.  Modification 4 (SPION binding based DNA extraction protocol 3B) 

 

In addition to modification 1, the following additional modifications were made: 

a) Step 5 of the SPION DNA extraction PROTOCOL 2A was altered. 0% PEG in 4 M 

NaCl was used as the binding buffer (Appendix 2). 
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2.2.3.4.1.5.  Modification 5 (SPION binding based DNA extraction protocol 4A) 

 

In addition to modification 1, the following additional modifications were made: 

a) A pre-lysis washing step was added (20 mM Tris buffer was used) to the SPION DNA 

extraction PROTOCOL 3A. 

1) Step 1. Into each tube containing the soil/semen mixture 500 µL of 20 mM Tris 

buffer was added and vortexed 5 times for 15 sec at low speed. 

Step 2. The samples were then centrifuged at 1000 rpm for 5 min and the 

supernatant discarded. 

Step 3. Steps 1 and 2 were repeated twice followed by the step 1 of the SPION 

DNA extraction PROTOCOL 3A (Appendix 3).  

 

2.2.3.4.1.6.  Modification 6 (SPION binding based DNA extraction protocol 4B) 

 

In addition to modification 1, the following additional modifications were made: 

a) A pre-lysis washing step was added (20 mM Tris buffer was used) (refer to the SPION 

DNA extraction protocol 4A, Appendix 4). 

Note: The pre-lysis washing step was carried out at 35 °C 
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2.2.3.4.1.7.  Modification 7 (SPION inhibitor binding protocol A) 

 

In addition to modification 1, the following additional modifications were made: 

a) A pre-lysis inhibitor binding step was introduced (20 µL SPIONs and 400 µL 4 M 

NaCl was used in this step).  

Step 1. Into each tube containing the soil/semen mixture 400 µL of 4 M NaCl and 20 

µL SPIONs were added. The samples were then placed on a flat-platform shaker and 

incubated for 10 min at 600 rpm. 

Step 2. Using a magnetic stand and blue p1000 tips most of the supernatant and the 

sample were transferred to a new tube. 

Step 3. Steps 1 and 2 were repeated twice followed by the step 1 of the SPION DNA 

extraction PROTOCOL 3A (Appendix 3). 

2.2.3.4.1.8.  Modification 8 (SPION inhibitor binding  protocol B) 

 

In addition to modification 1, the following additional modifications were made: 

a) Step 8. of the SPION DNA extraction Modification 7 was altered. 10 µL SPIONs were 

used during the DNA binding step. 

Refer to Appendix 5 
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2.2.3.4.1.9.  Modification 9 (SPION inhibitor binding protocol C) 

 

In addition to modification 1, the following additional modifications were made: 

a) Step 8. of the SPIONS DNA extraction Modification 7 was altered. 5 µL SPIONs were 

used during the DNA binding step. 

Refer to Appendix 5 

 

2.2.3.4.1.10.  Modification 10 (SPION binding based DNA extraction protocol 5A) 

 

In addition to modification 1, the following additional modifications were made: 

a) X2 lysis buffer containing 15% PVP was used in the lysis step (Appendix 13).  

DNA extraction was carried out according to the SPION DNA extraction PROTOCOL 

3A (Appendix 3). 

 

2.2.3.4.1.11.  Modification 11 (SPION binding based DNA extraction protocol 5B) 

 

In addition to modification 1, the following additional modifications were made: 

a) X2 lysis buffer containing 15% PVP was used in the lysis step (Appendix 13). 

b) Additional 1.5% PVP was added to the lysate (refer to the SPION DNA extraction 

PROTOCOL 3A, step 3. DNA extraction was carried out as described in the SPION 

DNA extraction PROTOCOL 3A (Appendix 3). 
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2.2.3.4.1.12.  Modification 12 (SPION binding based DNA extraction PROTOCOL 5C) 

 

In addition to modification 1, the following additional modifications were made: 

a) X2 lysis buffer containing 10% PVP was used in the lysis step (Appendix 13). 

Refer to Appendix 3 

 

2.2.3.4.1.13.  Modification 13 (SPION binding based DNA extraction protocol 5D) 

 

In addition to modification 1, the following additional modifications were made: 

a) X2 lysis buffer containing 10% PVP was used in the lysis step (Appendix 13). 

b) Additional 1.5% PVP was added to the lysate (step 3 of the SPION DNA extraction 

PROTOCOL 3A, Appendix 3). 

 

2.2.3.4.1.14.  Modification 14 (SPION binding based DNA extraction protocol 5E) 

 

a) 1.5% PVP was used in cell extraction procedure. 500 µL of 1.5% PVP was added to 

samples containing soil/semen mixture and vortexed for 5 min at low speed.  

b) Samples were then centrifuged at 1000  rpm for 30 sec and the supernatant transferred 

to a new tube containing 500 µL of the X2 Lysis buffer (incl. Proteinase K and DTT) 

following the Modification 3 protocol from step 2.  

Refer to Appendix 3 
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2.2.4.  Quantification of DNA 

 

Total DNA in extracted samples was measured using NanoDrop 2000 where 1 µL of each 

DNA sample was used to carry out the measurements. Prior to each measurement, calibration 

of the instrument was performed using an appropriate elution buffer. 

Amount of human DNA in the samples was measured using the Quantifiler Human DNA 

quantification kit (Appendix 9) and a real-time 9700 thermo-cycler.  

 

2.2.5.  Quantification of humic acid. 

 

Total amount of humic acid content in the extracted DNA samples was measured using 

Nanodrop 1000 UV-Vis (340 nm). 

A standard curve (R
2
= 0.99) was created by measuring absorbance (340 nm) of 6 known 

concentrations (ranging from 10 to 1000  ng/ µL) of commercially bought humic acid (Sigma 

Aldrich). 

 

2.2.6.  Agarose gel electrophoresis 

 

Agarose Gel electrophoresis was carried out by loading 5 µL of DNA extract and 1 µL of  6x 

loading dye (Thermo Scientific, UK) or 13.5 µL of PCR product and 1.5 µL of the 6x loading 

dye, onto 1% and 2% agarose gels, respectively, with 5 µL of  SafeView dye added. Samples 

were run for approximately 30 min at 50 V.  

Visualisation of the DNA bands on gel was performed using the BioDocit UV-

transilluminator. 
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2.2.7.  PCR 

 

PCR amplification was performed as described in 4-plex human, Bacterial 16S rDNA and 

PowerPlex 16 protocols using a 9700 thermo-cycler. 

Refer to Appendix 10: PowerPlex®16 Manual; 

Refer to Appendix 11: 4-plex PCR PROTOCOL for more detail; 

Refer to Appendix 12: Bacterial 16S rDNA PCR PROTOCOL for more detail; 

 

2.2.8.  Human STR DNA profiling 

 

STR genotyping was performed using the PowerPlex®16 kit and an ABI 3500 Genetic 

Analyzer Raw data was  analyzed using the GeneMapper-IDX Software.  

Refer to Appendix 10: PowerPlex® 16 Manual.  

Note: Validation of the Powerplex® 16 kit using samples from this study was first performed 

using full and half volume reactions (Target DNA concentrations were adjusted accordingly). 

In addition, 0.5 ng, for full reaction and 0.25 ng for half reaction volumes, of the target 

positive control DNA provided by the PowerPlex® 16 kit was mixed with 10 fold, 20 fold 

and 30 fold  non-target microbial DNA extracted from soil.  1 µL of the mixture was then 

used to perform PCR (refer to the PowerPlex® 16 Manual).  

 

2.2.9.  Statistical analysis  

 

One- , two-way ANOVA and Student T-test analyses  were carried out using Excel 2007 to 

determine significance between and within different sets of data. 
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3. Results 
 

Four different DNA extraction methods were compared using soil contaminated with three 

different body fluids (blood, saliva and semen) : phenol/chloroform, SPION binding, 

PowerSoil® MoBio and PrepFiler™ Forensic DNA isolation kit. The comparison of the DNA 

purification methods was carried out using a visual examination of the extracted DNA 

samples on agarose gels as well as PCR-based methods using PowerPlex®16 Human STR kit, 

4-plex and bacterial 16S rDNA primers (refer to the Appendix 10, 11 and 12, respectively). 

Note: 4-plex and bacterial 16S rDNA primers were used for the majority of comparison and 

optimisation experiments in order to reduce the costs. 

 

3.1.  Comparison of DNA extraction methods for isolation of PCR-ready 

DNA 

 

 

The results present in Table 4 were obtained from DNA extractions performed on 250 mg 

samples, containing soil contaminated with semen, using four DNA isolation techniques 

mentioned above. Results show that the PowerSoil® MoBio DNA extraction kit is most 

successful in purification of DNA from soil samples. DNA extracted using this method was of 

high quality (high molecular weight, HMW) and purity (permitting successful PCR 

amplification of full 4-band human (4-plex) and bacterial (16S rDNA) DNA products without 

the need of diluting the DNA extracts (Figure 4A). 

Extraction of DNA using the Phenol/Chloroform technique resulted in successful isolation of 

high molecular weight DNA (Figure 4D). However, the DNA extract was dark brown in 

colour (data not shown) and characteristic dark shadow smears were visible when run on an 

agarose gel (Figure 4D). In addition, PCR failed to amplify 4-plex and bacterial 16S rDNA 
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products even when 1 in 10 dilutions of the DNA extracts and increased amount (5U) of  Taq  

polymerase were used (note: for increased Taq experiments, only one sample out of each 

triplicate was used to keep the costs down).     

PrepFiler™ Forensic DNA isolation kit failed to extract PCR-ready DNA from soil 

contaminated  with semen. Extracted DNA was dark brown in colour (data not shown) and 

when run on an agarose gel, no DNA bands were present and characteristic dark shadow 

smears were visible (Figure 4C). PCR amplification targeting 4-plex human and bacterial 16S
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  PowerSoil Phenol/Chloroform PrepFiler SPIONs 

Gel electrophoresis of DNA  
Bright HMW DNA, no 

visible impurities*  
Very weak HMW DNA,  very high content 

of impurities* 
No visible HMW DNA, very high 

content of impurities* 

3 weak and hardly visible bands- very high 

content of impurities 

- DTT (on ice 

incubation) 

+ DTT (on ice 

incubation) 

No visible HMW 

DNA, high content 
of impurities* 

Bright HMW DNA, 

minimal 

degradation, low 
content of  

impurities* 

4-plex PCR 

Undiluted DNA 
extract 

4/4/4 0/0/0 0/0/0 -- 0/0/0 

1:10 DNA 

dilution 

 

-- 
0/0/0 0/0/0 -- 0/0/0 

Undiluted DNA  
+ 5 U Taq  

4 0 0 -- 0 

1:10 DNA 

dilution + 5U Taq 
-- 0 0 -- 4 

Bacterial PCR 

Undiluted DNA 
extract 

1/1/1 0/0/0 0/0/0 -- 0/0/0 

1:10 DNA 

dilution 
-- 0/0/0 0/0/0 -- 0/0/0 

*  content of impurities was determined by presence or absence of dark smears on agarose gels. 

0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

Table 4: Results of gel electrophoresis and PCR using DNA extracted using four different methods.   
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rDNA was not successful even with DNA diluted 1 in 10 and addition of 5U of Taq 

polymerase.    

DNA extraction performed using the standard SPION binding protocol resulted in DNA 

extracts which were  dark brown in colour (data not shown);and when run on an agarose gel, 

three bands of very weak intensity were seen  and characteristic dark shadow smears were 

present.  “On-ice” precipitation and addition of DTT to the lysis buffer resulted in isolation of 

DNA of much higher purity and when run on an agarose gel, three bright bands were visible 

together with some shadow smears being present (Figure 4B). PCR amplification failed to 

amplify human 4-plex and bacterial 16S DNA products with undiluted as well as  1 in 10 

diluted DNA. However, addition of 5U of the Taq polymerase as well as 1 in 10 dilution of 

the DNA extract permitted successful amplification of the 4-plex products.     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A B 

1 2 3 

C D 

1 2 3 1 2 3 1 2 3 

Figure 4: Agarose gel electrophoresis results comparing four different DNA extraction methods. A- DNA extracted using the 

PowerSoil®MoBio DNA isolation kit; B- DNA extracted using in-house manufactured SPION bindings; C- DNA extracted using 

PrepFiler™ Forensic DNA isolation kit; D- DNA extracted using organic Phenol/Chloroform technique. 1/2/3- each digit refers to a 

separate sample of the same triplicate.  
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DNA extraction using both SPION and the PowerSoil® MoBio DNA isolation kit from soil 

contaminated with saliva was also performed (data not shown). However, no human DNA 

was recovered, thus, all comparison studies as well as SPION optimisation experiments were 

carried out using  soil contaminated with semen.  

 

Results show that DNA extracted with the SPION binding protocol 1 (+ DTT) allowed 

successful amplification of the human 4-plex products. However, the purity of the DNA 

samples extracted using this method was not sufficient enough to permit PCR on undiluted 

DNA and standard   amount of the Taq (0.5 U per reaction). To further investigate this issue, a 

series of modifications were introduced to the protocol 1 (see following section). In addition, 

due to the fact that no visible DNA was present and much higher content of impurities was 

co-extracted (Table 4) when no DTT was used during the lysis step all further DNA 

extractions involved addition of DTT regardless of the modifications tested.   
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3.2.  Optimisation of the SPION binding based DNA isolation protocol  

 
Several modifications  (i.e. indirect lysis, direct lysis, pre-lysis washing, reduction of PEG 

concentration during SPION binding, pre-lysis SPION based inhibitor binding, and addition 

of PVP during lysis),  of the SPION binding protocol were compared in terms of purity and  

amount of DNA recovered (both human and total DNA) and whether PCR targeting both 

human and bacterial DNA was successful.  

 

3.2.1.  Comparison of direct and indirect DNA extraction approaches  

  

An indirect cell lysis method was compared to several direct cell lysis methods. The results in 

Table 5 reveal the indirect cell extraction method to be significantly better in reducing the 

amount of HA co-extracted during the DNA isolation procedure. The total amount of HA 

detected in the DNA samples extracted using this method was 8.46±1.33 ng/µL. In addition, 

the eluted DNA was not brown (data not shown) and no shadow smears were present when 

DNA was loaded onto an agarose gel.  

In contrast, every direct DNA extraction method tested, gave significantly higher amounts of 

HA  in the DNA samples. Highest yield of HA, 145.64±1.60 ng/ µL , was detected in DNA 

samples isolated using SPIONs (pre-lysis washing with 20 mM Tris at 35 °C) followed by     

8% PEG  (96.41±44.92 ng/µL), and 0% PEG (82.30±8.10 ng/µL) concentration during 

SPION based DNA binding, (20 mM Tris pre-lysis washing (66.15±4.28 ng/µL) and PVP 

direct lysis protocols where the total amount of HA ranged from 12.05±1.18 to 19.23±3.85 

ng/ µL.   

In addition, during the DNA elution step, change in colour of the elution buffer was observed 

(dark brown) for all samples with the exception of DNA isolated using the PVP direct lysis 

procedure (data not shown). 
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Both direct and indirect lysis methods were also compared in terms of their effectiveness in 

recovering DNA.  

DNA extraction procedures using the direct lysis approaches were  most successful in 

recovering high amounts of DNA. Total DNA yield ranged from 7.83±1.21 ng/µL to 

92.00±6.42 ng/µL for 15% PVP and 0% PEG concentration during SPION based DNA 

binding, respectively and were significantly higher than those detected in DNA samples 

extracted using indirect lysis (2.7±1.01 ng/µL).   

 

3.2.2.  Effects of PEG concentration on DNA yield and purity 

 

DNA extraction using the unmodified SPION binding based DNA extraction protocol 

(Appendix 1) where 20% final concentration of PEG in the binding buffer was used, was very 

problematic. Upon addition of the binding buffer to the lysate, the solution became very dense 

impairing separation of the nanoparticles from the liquid phase. Thus, different concentrations 

of PEG in the binding buffer were tested. Two binding buffers containing 16% and 0% PEG 

final concentration were prepared and DNA extraction was carried out according to the 

SPIONs based DNA isolation Modification 3 (Table 5). 

The binding buffer containing 20% PEG contained the highest amount of HA where over 500 

ng/µL was detected in the DNA samples (data not shown).  

DNA samples extracted using 0% PEG in the binding buffer gave the highest DNA yield of 

92.00±6.42 ng/µL followed by 20% PEG (51.47±2.57 ng/µL) and 16% PEG (23.57±1.86 

ng/µL).    

However, when run on an agarose gel, characteristic dark smears were present and PCR failed 

when undiluted DNA and 5U of Taq was used (Table 5). No significant difference in HA 

concentration  was observed between 0% and 16% PEG concentrations (p>0.05, student T-
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test). Reduction of PEG from 20% to 16% decreased the amount of HA almost 5 fold, thus 

16% PEG in the binding buffer was chosen for subsequent SPION tests .  

 

3.2.3.  Approaches to remove inhibitors 

 

3.2.3.1.  Addition of polyvinylpyrrolidone (PVP) 

  

Although direct lysis approaches resulted in much higher DNA yields than those employing 

indirect lysis procedures, the amount of HA co-extracted using these methods was too great to 

allow any PCR amplification to occur. Thus, four modifications to the SPION based DNA 

binding  Protocol 3A (Appendix 3) were introduced involving addition of 15%/10% PVP to 

the lysis buffer and additional 1.5%/0% PVP added to the lysate post-lysis (Table 5). 

In comparison to other direct lysis approaches, presence of PVP during the lysis step and 

further addition post-lysis greatly reduced the amount of HA co-extracted from 537.17 ng/µL 

(standard SPIONs binding protocol, data not shown) to 12.05±1.18 ng/µL ,  15.39±1.54 

ng/µL, 18.94±3.11 ng/µL and   19.23±3.85 ng/µL for samples containing 15% PVP (during 

cell lysis) and 1.5% PVP (post-lysis), 10% PVP (during cell lysis), 15% PVP (during cell 

lysis) and  10% PVP (during cell lysis) and additional 1.5% PVP (post-lysis), respectively. 

However, total DNA amount recovered (11.9±1.49 ng/µL) was at least two times lower than 

those with direct lysis methods containing no PVP (23.57±1.86 ng/µL ). Furthermore, no 

visible DNA was present when run on an agarose gel.   
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3.2.3.2.  Pre-lysis washing  

  

The results in Table 5 show that pre-lysis washing of soil samples using 20 mM Tris buffer 

significantly reduced the amount of HA co-extracted during the isolation procedure compared 

to the standard SPIONs binding protocol (data not shown).  

The total amounts of HA detected were 66.15±4.28 ng/µL and 145.64±1.60 ng/µL for 

samples extracted with modifications 5 and 6 of the SPION protocol, respectively. In 

addition, unlike the DNA extraction using lysis buffers containing PVP, pre-lysis washing 

steps recovered relatively high amounts of DNA ranging from   71.83±3.04 ng/µL to 

58.13±2.51 ng/µL for samples extracted using modification 6 and 5 of the  SPION protocol, 

respectively.  

 

3.2.3.3.  Pre-lysis SPION binding of inhibitors 

  

In this experiment, SPIONs were used before cell lysis to bind HAs. This protocol greatly 

reduced the amount of humic substance co-extracted during the DNA isolation procedure 

(Table 5). The total amount of HA detected in the DNA samples was 13.59±2.35 ng/µL being 

almost 40 times lower than those detected in the DNA extracted with standard SPIONs 

binding Protocol 1. In addition, the total DNA yield in these samples was 9.6±1.54 ng/µL, and 

lower than those extracted using other SPIONs modifications. However, low HA 

concentration together with sufficient amount of DNA present in these samples permitted 

successful amplification of the full 4-band product when 1 in 10 DNA dilution was used.  
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3.2.4.  PCR success 

  

The DNA extraction methods were also tested for their ability to recover PCR-ready human 

DNA using the Quantifiler kit (Tables 5, 7).  

Among all the SPION based DNA binding protocols and the commercial kits tested, the direct 

lysis with pre-lysis washing steps together with PrepFiler
TM

 Forensic DNA isolation kit gave 

the highest amounts of human DNA ranging from 3.88±1.17 ng/µL, 3.39±1.58 ng/µL to 

7.39±1.94 ng/µL for PrepFiler
TM

 (data not shown). The lowest amounts of target DNA were 

detected in samples extracted using indirect lysis + 1.5% PVP (0.40±0.12 ng/µL), direct lysis 

+ PVP (1.31±0.63 ng/µL) and the commercial PowerSoil® kit (0.82±0.28 ng/µL) (Table 7). 

However, The PowerSoil®  kit was the only DNA isolation method allowing successful 

amplification of the full 4-plex products from a range of sample amounts (from 25 mg up to 

the recommended  250 mg of the soil/semen mixture) (Table 7) without the need of 

performing DNA dilutions or increasing the amount of Taq used in each reaction (Ct< 28).  

The PrepFiler™ Forensic DNA isolation kit failed to extract DNA of sufficient purity to 

permit PCR amplification even when 1 in 10 DNA dilution and 5U of the Taq enzyme was 

used (Ct=39.87, data not shown).  

Among the modifications introduced to the SPION based binding protocol, only the pre-lysis 

SPION inhibitor binding protocol (Table 5) extracted DNA with sufficient purity to allow 

PCR amplification with DNA diluted 1 in 10 with no increase in the amount of the Taq 

enzyme (Ct= 29.71). However, for the majority of the modifications tested with the exception 

of the direct PVP lysis method (Modifications 10-13), successful PCR amplification of the 4-

plex product occurred when DNA samples were diluted 10 times and 5U of the Taq 

polymerase was used in each reaction.    
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Furthermore, to eliminate the possibility of PCR failure being due to insufficient 

concentration of the target DNA rather than inhibition, primers targeting bacterial 16S rDNA 

were used.  

Table 5 shows that no bacterial product was present, across all the modifications introduced to 

the standard SPIONs protocol, when undiluted DNA was used. However for DNA extracted 

using modifications 7,10-12 and 14, 1 in 10 dilution of DNA was sufficient to overcome the 

inhibition.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



46 

 

 

 

 Pre-lysis washing/SPION based inhibitor binding 
Reduction of PEG concentration 

during SPION based DNA binding 
Addition of PVP 

Gel electrophoresis 

20mM Tris 

(room temp) 

20mM Tris 

(35 °C) 

SPION 

binding 
PVP (1.5%) 

8% final 0% final 

Direct lysis (15% PVP) Direct lysis (10% PVP) 

1.5% extra to 

post-lysis 

supernatant 

0% extra to 

post-lysis 

supernatant 

1.5% extra to 

post-lysis 

supernatant 

0% extra to 

post-lysis 

supernatant Direct lysis (with soil present) 
Indirect lysis (no 

soil present) 

HMW DNA, 

less visible 
impurities 

HMW 
DNA, 

visible 

impurities 

HMW 
DNA, no 

visible 

impurities 

Weak HMW 

DNA, no visible 
impurities 

HMW DNA, less 

visible impurities 

Weak HMW 

DNA, visible 
impurities 

No visible bands 
No visible 

bands 

No visible 

bands 

No visible 

bands 

DNA[ng/µL] 58.13±2.51 71.83±3.04 9.6±1.54 2.7±1.01 23.57±1.86 92.00±6.42 7.97±0.35 7.83±1.21 11.9±1.49 9.57±0.61 

Human 

DNA[ng/µL] 

(Ct) 

3.39±1.58 

(37.41) 

7.36±1.94 

(39.04) 

1.75±0.18 

(29.71) 

0.40±0.12 

(27.85) 

2.64±0.15 

(35.04) 

2.21±0.93 

(37.01) 

0.21! 

(31.97) 
undetected 

1.31±0.63 

(34.92) 

0.64±0.19 

(30.78) 

HA[ng/µL] 66.15±4.28 
145.64±1.6

0 
13.59±2.35 8.46±1.33 96.41±44.92 82.30±8.10 12.05±1.18 18.94±3.11 19.23±3.85 15.39±1.54 

4-plex 

PCR 

Undiluted 

DNA 

extract 
0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 

1:10 DNA 

dilution 

 
0/0/0 0/0/0 4/4/4 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 

Undiluted 

DNA + 

BSA 

(20µg) 

0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 

Undiluted 

DNA + 5U 

Taq 
0 0 4 4 3 0 0 0 0 0 

1:10 DNA 

dilution + 

5U Taq 
4 4 4 4 3 3 0 0 0 4 

Bacterial 

PCR 

Undiluted 

DNA 

extract 
0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 

1:10 DNA 

dilution 

 
0/0/0 0/0/0 1/1/1 1/1/1 0/0/0 0/0/0 1/1/1 1/1/1 0/0/0 1/1/1 

0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

 

Table 5: Modifications introduced to the 20 µL SPION based DNA extractions using 250 mg soil contaminated with semen.   
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3.3.  Optimisation of the pre-lysis SPION based inhibitor binding protocol 

 

 

According to the results presented in Table 5, SPION inhibitor binding protocol (Modification  

7) was most successful at isolating DNA of sufficient purity to allow 4-plex amplification 

after 1:10 dilution without the addition of extra Taq without compromising the amount of the 

target DNA recovered.  

However, due to the fact that the extraction procedure was highly problematic, where the 

separation of the magnetic beads from soil particles was very challenging, only approximately 

half of the sample was successfully transferred to the final step of the lysis procedure 

(Appendix 5).  

Consequently, several sample amounts were tested to assess the optimal sample amount. In 

addition, different SPIONs amounts (20, 10 and 5 µL)  were also tested for the DNA binding 

step to determine the most suitable amounts of SPIONs for isolation of PCR-ready DNA. 
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*- DNA smear on gel (difficult to distinguish the 4 bands) 

!- concentrations of human DNA could be determined for two or less samples of triplicate (SE could not be calculated). 

0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

 

Sample amounts[mg] 
5 25 50 100 125 250 

Amounts of SPIONs used for DNA binding[µL] 
20 10 5 20 10 5 20 10 5 20 10 5 20 10 5 20 10 5 

Gel  

electrophoresis 
No visible bands No visible bands No visible bands No visible bands 

3 very weak 

bands 

No 

visible 
bands 

3 very weak 

bands 

No 

visible 
bands 

DNA[ng/µL] 6.87 ±0.71 2.17 ±0.31 1.03 ±0.84 
6.10 

±0.26 

4.97 

±0.15 

4.93  

±0.38 

4.27 

±0.47 

5.27 

±0.38 

3.53 

±0.40 

7.67 

±0.31 

5.93 

±0.85 

6.03 

±0.25 

8.13 

±1.05 

4.17 

±1.40 

5.87 

±1.17 

9.13 

±0.67 

7.00  

±0.20 

5.87 

±0.21 

Human DNA 

[ng/µL] 

(Ct) 

undetected undetected undetected 
0.21! 
(27.5) 

0.16! 
(27.63) 

0.15 

±0.06 

(29.43) 

0.78 

±0.40 

(28.78) 

0.24 

±0.17 

(29.98) 

0.45 

±0.22 

(29.54) 

1.43 

±0.70 

(29.01) 

1.88 

±0.20 

(28.63) 

0.73 

±0.42 

(28.05) 

2.01 

±0.27 

(31.3) 

1.82 

±0.57 

(28.09) 

1.24 

±0.35 

(30.04) 

2.27 

±0.19 

(30.89) 

1.71 

±0.18 

(29.04) 

1.87 

±1.06 

(29.68) 

HA[ng/µL] 
22.31 

±7.34 

15.90 

±2.35 
8.72 ±1.18 

13.08 

±3.35 

10.26 

±1.18 

27.95 

±16.45 

16.41 

±1.18 

15.90 

±4.24 

15.90 

±2.35 

20.26 

±1.18 

24.81 

±1.94 

25.38 

±18.67 

21.28 

±1.18 

12.56 

±0.44 

20.77 

±8.03 

21.79 

±2.22 

14.87 

±0.89 

16.41 

±1.94 

  
4-plex 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 4/4/4 0/0/0 0/0/0 0/0/0 0/0/0 

4-plex 1:10 

DNA dilution 
0/0/0 0/0/0 0/0/0 4/4/4 0/3/3 0/4/2 4/4/4 4/0/4 4/1/3 4/4/4 3/0/4 4/4/4 4/4/4 4/4/4 4/4/4 4/4/4 4/4/4 4/4/4 

4-plex 1:10 

DNA dilution 

+ 5U Taq 

4 0 0 * 0 * * 0 0 4 4 4 4 4 4 4 4 4 

Bacterial 16S 

rDNA 
0/0/0 1/1/0 1/1/1 0/0/0 0/0/0 1/1/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 0/0/0 

Bacterial 16S 

rDNA 1:10 

DNA dilution 

1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 

Table 6: Modifications introduced to the SPION based inhibitor binding method for DNA extraction.   
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According to the results obtained from DNA extractions from different sample amounts as 

well as different amounts of SPIONs used for DNA binding step, no significant changes in 

concentrations of HA were observed. However, no visible DNA was present on an agarose 

gel when extraction was performed on samples lower than 125 mg and using less than 10 µL 

of SPIONs. Highest amounts of total and human DNA were detected in samples extracted 

from (100, 125 and 250) mg of the soil/semen mixture, ranging from 5.87±0.21 ng/µL to 

9.13±0.67 ng/µL of the total DNA (Table 6). The ratio of total to human DNA did not exceed 

10 for all the samples extracted from (100, 125 and 250) mg of the soil/semen mixture 

regardless of the amount of SPIONs used for the DNA binding step, showing that the SPION 

extraction method is efficient in isolation of target DNA from nucleic acid mixtures.  

Overall, the lower the amount of soil/semen mixture  and/or SPIONs used for the DNA 

extraction the higher the total : human DNA ratio (p<0.05, two-way ANOVA). In addition, no 

human DNA was detected in the samples extracted from 5 mg of the soil/semen mixture.  

This protocol was also tested for its ability to extract PCR-ready DNA. The results in table 6 

show that DNA extracted using this method isolate DNA with sufficient purity to permit PCR 

amplification when 1 in 10 DNA dilution was used.  

Although, no amplification occurred when DNA extracted from 5 mg and some samples from 

25 mg and 50 mg of the soil/semen mixture was added to the 4-plex reaction mix, 

amplification of the bacterial 16S rDNA product was successful across all the sample amounts 

presented in Table 3 (1 in 10 DNA dilution only). In addition, for DNA isolated from 5 mg 

samples, no DNA dilution was necessary to permit PCR amplification of the 16S rDNA 

product when 5 µL and 10 µL SPIONs was used for the DNA binding step.    

In order to directly compare these results with Powersoil®, the entire sample range was also 

tested using PowerSoil® (Table 7). 
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Figure 5: Amounts of total DNA recovered using the commercial PowerSoil® DNA kit and SPIONs, 

where three different amounts of magnetic beads were used for the DNA binding step.  

 

 

Figure 6: Amounts of HA co-extracted during the DNA isolation procedure using the commercial 

PowerSoil® DNA kit and SPIONs where three different amounts of magnetic beads were used for the 

DNA binding step.   
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PowerSoil® MoBio  

Sample amounts[mg] 
5 25 50 100 125 250 

Gel  

electrophoresis 
No visible DNA Weak HMW DNA HMW DNA HMW DNA HMW DNA HMW DNA 

DNA[ng/µL] 0.87±0.61 2.03±0.68 0.33±0.15 3.83±0.21 4.07±0.25 5.13±0.44 

Human DNA 

[ng/µL] 

(Ct) 

0.03±0.02 
(27.67) 

0.38±0.07 
(27.77) 

0.51±0.30 
(27.84) 

0.19±0.02 
(27.76) 

0.77±0.15 
(27.65) 

0.82±0.28 
(27.87) 

HA[ng/µL] 4.10±0.44 4.36±0.44 4.36±0.44 4.87±0.44 4.36±0.44 5.13±0.44 

  
4-plex 0/0/1 4/4/4 4/4/4 4/4/4 4/4/4 4/4/4 

Bacterial 16S 

rDNA 
1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 1/1/1 

0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

Table 7: DNA extractions on a range of soil/semen sample quantities using a PowerSoil®MoBio kit.  
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Figures 5 shows correlation between sample amounts and the total DNA recovered using the 

commercial PowerSoil® and SPION based binding methods as well as the amounts of HA co-

extracted with these procedures (Figure 6).  

As mentioned previously, PowerSoil® DNA isolation kit is most efficient at removing HA 

from soil extracts. The total amount of HA co-extracted using this kit was far lower than those 

seen using SPIONs and did not exceed 6 ng/µL regardless of the amount of soil used for DNA 

extraction (Table 7, Figure 6). However, although the amount of total DNA recovered using 

PowerSoil® increases with sample amounts, the SPION based DNA extraction technique 

successfully extracted more DNA across the whole sample range, even when 5 µL of SPIONs 

was used for the DNA binding step (Figure 5).   
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3.4.  DNA profiling 

 

The Purity of the isolated DNA was also tested by generating a DNA profile using the 

PowerPlex 16® kit.  

Prior to DNA profiling, a validation exercise  was performed to assess whether the presence 

of the large amounts of non-target DNA influenced generation of a good profile  using the 

Powerplex 16® kit and  to estimate the variation in TPH and MLB values from different 

amplifications of the same sample using triplicates.  

Target DNA (0.5 ng) was spiked with 5, 10 and 15 ng of microbial DNA extracted from soil 

using the PowerSoil® DNA extraction kit followed by DNA profiling. 

No significant difference in TPH was observed between triplicate samples (p=0.15, one-way 

ANOVA). MLB, significantly decreased with increasing amount of the non-target DNA 

present (p=0.02, one-way ANOVA). However, it appeared like there was no significant 

difference in MLB variations within each triplicate (data not shown). 

 

Results of DNA profiling of DNA isolated using SPIONs and PowerSoil® are summarised in 

Figures 11-25 (Appendices 14-28), TPH and MLB values are shown in Figures 7 and 8. 

Regardless of the amount of the semen/soil mixture used to perform the DNA extraction, the 

TPH for PowerSoil®- extracted DNA were at least twice as high as those obtained from 

corresponding amounts using SPIONs, with a maximum rfu of 28000  (Figure 7).  

The highest TPH values for SPION binding based DNA extracts were  11131 and 10784 rfu 

and were obtained from DNA extracted using 10 µL and  5 µL of SPIONs and 100 mg of the 

soil/semen mixture respectively.   
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Figure 7: Total peak height (TPH) for DNA profiles generated from DNA extracted using PowerSoil® and 

SPIONs from 25, 50, 100, 125 and 250 mg of the semen/soil mixture. 

Figure 8: Mean local balance (MLBs) for DNA profiles generated from DNA extracted using PowerSoil® and 

SPIONs from 25, 50, 100, 125 and 250 mg of the semen/soil mixture. 
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No clear relationship between the amount of SPIONs used and the TPH values was observed 

across the whole range of sample amounts. The TPH obtained from 25 mg of the soil/semen 

mixture and 5 µL SPIONs is over 3 times as high as those from the other two SPION amounts 

using 25 mg. The TPH values decrease with decreasing amount of SPIONs in 50 mg samples 

whereas 10 and 5 µL SPIONs appear optimal for DNA extraction from 100 mg samples. 

Figure 8 shows the MLB values for all the DNA profiles generated.  

Profiles obtained from DNA extracted using the PowerSoil® kit are highly balanced with 

MLB values exceeding 0.8 for all sample amounts tested with the highest value of 0.89  

observed in 125 mg samples. It appears that the amount of soil/semen mixture used to 

perform the DNA extraction procedure did not affect the balance of the profiles generated, 

with the entire range from 5 mg to 250 mg generating highly balanced profiles. Furthermore, 

the most balanced profile for SPION binding based DNA extraction with a MLB of 0.86, was 

obtained from 250 mg samples when 20 µL of SPIONs were used for the DNA binding step; 

slightly exceeding the MLB values of profiles generated from 250 mg PowerSoil® samples 

(MLB= 0.84).  

MLB values for the profiles obtained from DNA isolated from (100, 125 and 250) mg 

samples using PowerSoil® are similar to those acquired from SPIONs-extracted DNA. 

The SPION protocol where 100 mg sample and 10 µL of the magnetic beads were used 

appeared to be the most optimal when both the MLB and TPH are taken into consideration.     
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0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

 

 

Sample amounts[mg] 

25 100 250 

Amounts of SPIONs used for DNA binding[µL] 

20 10 5 20 10 5 20 10 5 

Gel  

electrophoresis 
No visible bands No visible bands 

3 very weak 

bands 
No visible bands 

DNA[ng/µL] 1.27±0.55 0.00 0.00 1.10 0.17±0.06 0.16±0.15 4.60±2.20 0.87±0.21 1.77 ±0.05 

Human DNA [ng/µL] 

(Ct) 

0.18±0.02 

(29.89) 

0.06 

(29.35) 

0.28 

(29.64) 

0.09 

(30.85) 

0.18 

(29.82) 

0.29 

(29.78) 

0.38±0.27 

(30.97) 

0.44±0.22 

(29.41) 

0.20 

(30.01) 

HA[ng/µL] 14.36±1.94 8.21±0.44 5.64±0.089 36.15±6.84 8.46±0.77 12.05±0.89 38.97±25.56 6.92±0.77 10.00±1.54 

 

4-plex undiluted DNA 0/0/4 4/4/4 0/0/0 0/0/0 4/4/4 0/4/4 0/4/4 4/4/4 0/0/0 

4-plex 1:10 DNA dilution 0/0/0 4/0/0 0/0/0 4/4/4 3/4/4 0/4/4 0/0/0 0/0/0 4/0/0 

4-plex undiluted DNA 

dilution + 5U Taq 
0 4 0 4 4 4 4 4 4 

Bacterial 16S rDNA 0/0/0 1/1/1 1/1/1 1/0/0 1/1/1 1/1/1 1/1/0 1/1/1 1/1/0 

Bacterial 16S rDNA 1:10 

DNA dilution 
1/1/1 1/0/0 0/0/0 1/1/1 1/0/0 0/0/0 1/1/1 0/0/0 1/1/1 

Table 8: SPION binding based DNA extractions using a range of blood/soil sample amounts. 
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Sample amounts[mg] 

25 100 250 

Gel  

electrophoresis 
Weak HMW DNA HMW DNA HMW DNA 

DNA[ng/µL] 1.03±0.40 2.33±0.32 4.10±0.26 

Human DNA [ng/µL] 

(Ct) 

0.64±0.13 
(27.54) 

1.15±0.21 
(27.65) 

1.45±0.27 
(27.64) 

HA[ng/µL] 3.85 4.10±0.44 4.87±0.44 

  

4-plex undiluted DNA 4/4/4 4/4/4 4/4/4 

Bacterial 16S rDNA 1/1/1 1/1/1 1/1/1 

 

0/0/0- each digit represent a separate sample of the same triplicate and encodes for the number of bands observed on an agarose gel (a single band for the bacterial 16S rDNA 

and four bands for the 4-plex amplification reaction). Note: all the amplification reactions carried out with 5U of Taq were performed as a single replicate.    

Table 9: DNA extractions with the PowerSoil® DNA isolation kit (MoBio) using  a range of soil/blood sample quantities. 
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3.5.  Comparison of the optimised SPION based DNA extraction protocol 

and the  PowerSoil® kit for recovery of PCR-ready DNA from blood 

contaminated soil samples 

 

The previously optimised SPION binding  based DNA isolation method and the PowerSoil® 

kit were also used to compare their ability to recover PCR-ready DNA from different amounts 

(25, 100 and 250) mg of blood/soil mixtures. 

Tables 8 and 9 summarise the results, showing that the Powersoil® kit was  much more 

efficient at both inhibitor removal and DNA isolation. PowerSoil® was able to recover 1.03, 

2.33 and 4.10 ng/ µL total DNA from (25, 100 and 250) mg samples respectively, with HMW 

bands visible on an agarose gel across the entire sample range (Table 9). In contrast, DNA 

concentrations isolated using the SPION binding based method ranged from 0.16 ng/µL up to 

4.60 ng/µL (Table 8). No DNA was detected in samples extracted from 25 mg of the 

blood/soil mixture using 10 and 5 µL of SPIONs. In addition, no DNA bands were present 

when run on an agarose gel with the exception of DNA extracted from 250 mg of the 

soil/blood mixture using 20 µL SPIONs, where weak HMW DNA bands were visible. 

 

Furthermore, amounts of HA co-extracted during the PowerSoil® DNA isolation procedure 

did not exceed 5 ng/µL (Table 9), whereas over 30 ng/µL of the inhibitor was present in 

samples extracted from 100 and 250 mg using 20 µL SPIONs or between 5 and 12 ng/µL in 

the remaining sample and SPIONs amounts.  

Total amounts of human DNA recovered using SPIONs were relatively low (0.06-0.44 ng/µL) 

as opposed to 1.45, 1.15 and 0.64 ng/µL extracted from 250, 100 and 25 mg, respectively, 

using PowerSoil® isolation kit.  

Moreover, unlike previous results using semen/soil samples (Table 6) where no PCR product 

was detected when undiluted DNA was used, for samples extracted from 250 (20 and 10 µL 
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SPIONs), 100 (10 and 5 µL SPIONs) and 25 mg (10 µL SPIONs) the 4-band product was 

visible on an agarose gel. In addition, the bacterial 16S rDNA product was also present for all 

sample amounts using undiluted DNA with the exception of DNA extracted from 25 mg of 

the soil/blood mixture using 20 µL SPIONs where 1 in 10 dilution of DNA was necessary for 

successful amplification to occur. However, in case of DNA extracted from 250 (10 µL 

SPIONs), 100 (10 and 5 µL SPIONs) and 25 mg (10 µL SPIONs), DNA dilution appeared to 

have an adverse effect on PCR success.  

In contrast, no DNA dilution was required to permit PCR on DNA extracted using the 

PowerSoil ® isolation kit.  

 

3.5.1.  DNA profiling 

 

Powerplex® 16  profiles generated from DNA isolated using SPIONs and PowerSoil were 

once again compared. TPH and MLB were evaluated using profiles generated from 250 mg of 

the blood/soil mixture for both PowerSoil® and SPIONs (20 µL SPIONs used for DNA 

binding). Most of the profiles produced from DNA extracted using the SPION binding based 

method, with the exception of 250 mg and 20 µL SPIONs were unreadable ( 10 or more loci 

missing with very low peak heights and high background noise) in contrast to good profiles 

using Powersoil® (data not shown).  

TPH (28677 rfu) of triplicate profiles generated from PowerSoil®-extracted DNA (250 mg) 

was over eight times higher than those (3265 rfu) from corresponding sample amounts using 

SPIONs based DNA binding approach (Figure 9). 

Although, the TPH of the profiles acquired from SPIONs-extracted DNA was lower, they 

were relatively balanced (>0.4) with an MLB of 0.70. However, the purity of DNA extracted 

using the Powersoil kit was clearly much higher, reflected in both TPH and the MLB (0.94) 

(Figures 9 and 10).  
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Figure 9: Total peak height (TPH) for DNA profiles generated from DNA extracted using 

PowerSoil® and SPIONs from 250 mg of the blood/soil mixture. 

Figure 10: Average  mean local balance (MLB) for DNA profiles generated from DNA extracted 

using PowerSoil® and SPIONs from 250 mg of the blood/soil. 
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3.6.  Assessing PCR inhibition 

 

PCR inhibition was also assessed by using the Quantifiler ® Human DNA quantification kit 

and looking at the Ct valuses of the interrnal positive controls (IPC) for each DNA sample 

tested.  

As the previous results suggested, the DNA samples extrected with the PowerSoil® kit, 

showed the  lowest or none degree of inhibition of the IPC (Ct<28).  In contrast, the 

PrepFiler™ kit extracted DNA with the lowest purity resulting in the highest degree of 

inhibition among all the  DNA extraction method tested (Ct= 39.87) (Tabels 5-9).  

SPION based DNA purification method managed to extract DNA of a moderate purity with 

the Ct values being in a range between 27.5 and 39.04 depending on the modification used. In  

addition, among the SPION-based DNA purification methods, the lowest inhibition was 

detected in the samples extracted with SPION inhibitor binding and the 1.5% PVP indirect 

lysis protocols (Ct<28) whereas the highest degree of inhibition was observed in the samples 

extracted with the direct lysis approaches (pre-lysis washing, Table 5). 

 

Furthermore, in comparison to other SPION inhibitor binding DNA purification methods, 125 

mg and 10 µL SPION showed to be most optimal in terms of PCR efficiency. Almost 2 ng of 

the target DNA together with low amounts of HA (~12 ng/µL)(Ct= 28.09) allowed successful 

amplification of the 4-band 4-plex product without the need of dilution (Table 6). 

DNA extraction from blood contaminated soil using the SPION inhibitor binding protocol 

showed slightly higher Ct values comparing to the semen/soil samples (Table 8). However, 

the amounts of detected HAs were similar (~15-35 ng/µL).   
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4.  Discussion 
 

Forensic human DNA profiling has greatly evolved over the last thirty years. The transition 

from using VNTRs to employing highly  sensitive PCR based STR genotyping has been 

highly beneficial,  reducing time and the  complexity of analysis as well as the amount of 

biological material required. However,  PCR inhibition remains  a major  drawback.  

Soil is one of the most difficult matrices to extract PCR-ready DNA from, where the 

significant amount of non-target DNA present  is not the only issue encountered. Soils are 

mixtures of organic and inorganic materials such as minerals, humic substances, a variety of 

microorganisms, heavy metals or other substances associated with pollution, many of which 

can potentially inhibit PCR. Thus, effective DNA extraction methods for soil that do not 

employ time-consuming techniques of sample purification (e.g. size-exclusion 

chromatography) and result in PCR ready DNA are highly desirable. Moreover, the ideal 

method would also be suitable for automation, eliminating human error as well as potential 

cross contamination associated with sample processing. 

 

4.1.  Comparison of DNA extraction methods 

 

Four DNA extraction methods were compared, two of which were commercially available 

DNA extraction kits. The initial comparison of the chosen methods using semen/soil mixtures 

confirmed previous findings that extraction of PCR-ready DNA from soil samples was 

particularly difficult due to co-extraction of HAs (Matheson et al. 2010, Sebastianelli et al. 

2008, Spanova et al. 2006, Steffan et al. 1988). Currently, there are many DNA extraction kits 

available commercially, however even for some of these (e.g. PrepFiler™ Forensic DNA 

isolation kit) soil still poses a great challenge in terms of DNA purification.  
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The initial comparison showed that although phenol/chloroform extraction and the 

commercial PrepFiler™ were efficient at isolating DNA (over 2 ng of the target DNA was 

detected by the Quantifiler® Human Quantification kit, data not shown), the sample 

purification was very poor (Table 1). Unlike PowerSoil®- and SPION based-extraction, 

sample dilution and addition of 5U Taq were not sufficient to overcome the PCR inhibition.  

The organic phenol/chloroform method relies on organic and water-soluble phase separation 

and DNA is extracted within the aqueous phase during the phase separation step. The mode of 

DNA isolation used by the PrepFiler™ kit is most likely based on the charge differences 

between DNA molecules and the magnetic beads used for the DNA binding step where 

positvely charged PrepFiler™ magnetic beads use the negative charge of DNA molecules for 

the binding. However, HAs and DNA both share the same chemical features (i.e. charge and 

solubility) which creates a problem with removal of HAs  using these DNA extraction 

techniques. Both HAs and DNA are water-soluble, negatively charged molecules which co-

migrate into the aquenous phase during the organic phenol/chloroform DNA isolation 

procedure and are both attracted to the positively charged surface of the PrepFiler™ magnetic 

beads. Despite the fact that both of these methods have been shown to successfully purify 

HMW DNA from variety of samples such as blood and  bones (Brevnov et al. 2009), they 

were unsuccessful  at purifying DNA from HA-rich soil in this study. Since the exact 

composition of the PrepFiler™ magnetic beads is unknown it is difficult to understand the 

reason behind the failure to extract DNA of sufficient purity. Possibly the increased binding 

area as well as the affinity of the inhibitor to the surface of the beads caused the experiments 

to fail at extraction of high purity DNA.  

 

Several researchers have shown that as little as 1 ng of HA can reduce PCR efficiency and   

10 ng is sufficient to completely inhibit the reaction (Tien et al. 1999, Tsai and Olson 1992b). 
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Amounts of HA co-extracted using the organic and PrepFiler™ methods were over 50 times 

higher than the above inhibition threshold (data not shown) as opposed to, on average, only 3 

times higher with the SPION binding based approach (Table 6). 

The PowerSoil® DNA extraction method was found to be most successful at purification of 

PCR ready DNA from soil samples regardless of the amount of body fluid/soil used. 

However, like many another purification methods such as gel filtration or size-exclusion 

chromatography, DNA yield is usually compromised in favour of high sample purity 

(Alaeddini 2012, Zhou et al. 1996).  The amounts of total DNA recovered from the 

soil/semen mixture using this method did not exceed 10 ng/µL whereas SPION binding based 

DNA isolation resulted in up to 90 ng/µL of DNA (average 60 ng/µL)  (Table 5). In addition, 

the PowerSoil® purification steps involved several centrifugation and sample re-pipetting 

steps that are both time consuming and could potentially cause cross contamination. The 

SPION binding based extraction in contrast, did not require these additional steps. 

 

No positive results were obtained from extraction of DNA from saliva/soil mixture using both 

PowerSoil® and SPION binding based extraction. On average, amounts of total DNA 

recovered from 250 µL or saliva ranged between 2.5 and 3.3 ng/µL, which supports previous 

findings reporting saliva to be a poor source of DNA (Sweet et al. 1996, Virkler and Lednev 

2009). In addition, a large fraction of the DNA recovered from saliva consists of microbial 

DNA. Thus, results from this study suggest soil contaminated with saliva to be an unsuitable 

source of DNA for forensic analysis.   

 

However, since no extensive testing of the soils used in this study was performed (i.e. both in 

terms of their chemical and biological composition) and no comparison to other soils found in 

the surrounding urban areas were carried out, the results obtained with this study might not 
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entirely reflect on the usefulness of the DNA purification methods mentioned above (organic 

DNA purification and Prepfiler™). As mentioned previously (p. 14), various types of soils 

(sands, silts, clays, loams) contain different amounts of organic matter where the rate of its 

decomposition can significantly vary. Since HA is produced during decomposition of the dead 

plant material found in soils, and loamy soils shows the highest rate of decomposition, it 

could be assuemed that the soil samples chosen for this study were particularly reach in HA-

like substances resulting in greater co-extraction of HA (as opposed to sands or silts).  

 

4.2.  Optimisation of the SPION based DNA binding method 

 

The SPION binding  based DNA isolation method performed better than the organic and the 

commercial PrepFiler™ DNA purification methods with respect to the quantity and purity of 

DNA extracted. Furthermore, the SPION binding based method  was superior to the 

PowerSoil® kit in terms of DNA yield. In attempts to improve the purity of the DNA 

extracted using the SPION binding based method, several modifications to the protocol were 

tested. 

Since DNA binding using SPIONs was based on the electrostatic interactions between the 

bead’s surface and both DNA and HA molecules, and no changes to the actual surface of the 

beads could be introduced, overcoming the issue of co-extraction of HA during the DNA 

isolation process could only be achieved by : precipitating HAs, modifying the cell lysis step,  

addition of substances that would enhance binding of DNA and  HAs (thus neutralising its 

negative charge), and altering the amount of sample and/or magnetic beads used for DNA 

extraction which in turn would enable extraction of sufficient PCR ready DNA suitable for 

DNA profiling with  low concentration of HA  permitting successful PCR amplification.  

Several modifications were used in conjunction with one another to achieve best results at 

purifying DNA from HA-rich samples. 
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4.2.1.  Precipitation of HAs 

   

One of the methods of reducing HAs content in extracted DNA is precipitation in the presence 

of sodium cations at pH>8.0. Increased pH makes the reaction between HA and sodium ions 

favourible resulting in production of water insoluble HA salts. 

Despite the fact that precipitation of HAs using an on-ice incubation   introduced an additional 

centrifugation step, it reduced the amount of HA co-extracted by more than  20 % (on average 

80 ng/µL) (data not shown) and therefore was kept as an essential step in all further SPION 

based DNA extractions.  

 

4.2.2.  Optimisation of the DNA binding step using PEG 

 

Froehlich and many others found that PEG promotes DNA condensation and can therefore be 

used as alternative method of DNA isolation when combined with high salt concentration 

buffers (Froehlich et al. 2011). The very feature of PEG causing DNA to aggregate was hoped 

to facilitate the DNA binding procedure, where the stronger negative charge of the aggregates 

would have higher affinity to the positively charged surface of the magnetic beads and 

therefore bind more efficiently reducing the amount of HA being co-extracted. However, a 

higher viscosity of the solution caused by the binding buffer containing 20% PEG had an 

adverse effect on DNA purity. Separation of the magnetic beads from the lysate using a 

magnetic stand separator was impaired by the solution’s viscosity in turn making washing 

steps much more difficult, resulting in sample loss and co-extraction of higher amounts of 

HA. Reduction of PEG to 16% in the binding buffer decreased the amount of HA in the final 

DNA extract by over 5 fold but successfully purified  over 20 ng/µL of total DNA which 

confirmed previous findings by (Spanova et al. 2006) that optimal PEG and salt 

concentrations are crucial in obtaining sufficient amounts of DNA. 
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Results of HA quantification suggest that total amounts of HA co-extracted were highest 

when 20% PEG was used in the binding buffer (> 500 ng/µL) and lowest when either 16% 

PEG or no PEG was used in the binding buffer (Table 5).  Zavarzina et al. (2002) found that 

PEG can adsorb onto silica surfaces through hydrogen-bonding. This could be the cause of 

larger amounts of HAs being co-extracted in presence of higher concentration of PEG. The 

amount of total DNA detected when no PEG was used was higher than those extracted with 

PEG suggesting that the adsorbtion of PEG onto the SPION surface could have impared the 

interaction between the SPIONs and DNA molecules resulting in reduced DNA yield. 

However, the intensity of the DNA bands on agarose gel was much lower in case of DNA 

extracted without the presence of PEG in the binding buffer (Table 5). The differences in 

intensities of the bands could suggest that DNA degradation (shearing) was much more 

frequent in these samples. Condensation of DNA in the presence of PEG could possibly have 

a protective effect on DNA molecules preventing shearing during the extraction procedure. 
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4.2.3.  Comparison of direct and indirect lysis 

 

Both direct and indirect lysis methods were compared in terms of DNA yield and HAs 

content.   

Since the indirect lysis method relied on retention of intact cells, which in turn resulted in 

some sample loss (due to rupture of some cells during pipetting etc.), less target DNA was 

isolated. The DNA yield was up to 30 fold lower than those extracted using the direct lysis 

approaches (2.7±1.01 ng/µL as opposed to 92.00±6.42 ng/µL, Table 2). In addition, HA 

content in the DNA samples extracted using indirect lysis was on average 10 fold lower than 

in all direct lysis extractions which support previous findings suggesting indirect lysis to be a 

more suitable DNA extraction method for recovery of DNA of higher purity from inhibitor 

rich matrices (Steffan et al. 1988). However, many current, commercially available DNA 

isolation kits are able to isolate DNA of high purity (e.g. PowerSoil®, UltraClean®) without 

the need of using indirect lysis approaches, and consequently, indirect lysis  is no longer in 

use.  

  

4.2.4.  Addition of PVP 

 

PVP has been successfully used in agarose gel-based filtration methods to separate DNA from 

HAs (Steffan et al. 1988, Young et al. 1993, Zhou et al. 1996). Robe et al.  has suggested that 

PVP can retard phenolic compounds that usually co-migrate with DNA molecules during 

agarose gel electrophoresis. Although, the method was effective in removing HAs from DNA, 

the steps involved in DNA purification were highly time consuming.  

In this study, 15% PVP was added directly into the lysis buffer followed by the standard 

SPION binding based DNA isolation protocol. The results confirmed previous findings 

claiming PVP to be an effective method in purification of DNA from HA-rich samples 

(Young et al. 1993)-Addition of PVP (10%, 15%) reduced HA co-extraction by up to 120 ng 
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per µL of DNA extract in comparison to other direct lysis methods (Table 5). Despite the fact 

that amounts of HA present in the final extracts was very low (<20 ng/µL), the method was 

highly unsuccessful in terms of DNA yield. Presence of 15% and 10% PVP in the lysate 

seemed to have an adverse effect on binding of both HA and DNA by the magnetic beads and 

DNA yields were up to 7 times lower than those acquired with other direct lysis methods 

(Table 2). In addition, much higher sample purity achieved with the indirect lysis method 

could have also been partially caused by the presence of 1.5% PVP in the buffer, further 

reducing both the HA and DNA content.  

It has been previously suggested  that gel filtration using agarose containing  PVP caused 

DNA loss (Young et al. 1993). Similar to PEG, PVP could interfere with the DNA binding 

mechanism by either interacting with the magnetic bead’s surface or more likely DNA 

molecule itself.  

 

4.2.5.  Sample pre-treatment  

 

Sample pre-treatment was yet another method tested for  reducing HAs. The method was 

based on the solubility of HAs in aqueous solutions where by performing  washes (20 mM 

Tris buffer) of the soil/body fluid mixture and removal of the liquid phase, a reduction in the 

amount of HA in the  samples could be achieved.  

Although, the sample pre-washing step carried out at RT reduced the amount of HA co-

extracted by approximately 15% (66.15±4.28 ng/µL compared to over 500 ng/µL extracted 

with the standard SPIONs protocol),  sample purity was not sufficient to permit successful 

PCR amplification. In addition, the method involved several centrifugation steps which were 

both time consuming and could potentially cause cross contamination. In general, sample pre-

treatment resulted in the highest DNA yields in comparison to all other modifications tested. 

A reduction in HA content as a result of the pre-treatment combined with direct lysis 



70 

 

approaches is most likely to be responsible for the increased DNA yield since less HA  

occupied the SPION surfaces leaving more  ”binding sites” for DNA molecules.  

Moreover, sample pre-treatment carried out at 35 °C resulted in almost 2.5 fold increase in 

HA content and 1.2 fold increase in DNA yield (Table 5) suggesting that solubility of HAs 

increases with temperature. This increase in HA was most likely due to the fact that a small 

fraction of the buffer used to perform the wash step was always left behind after each 

centrifugation step to ensure that no sample was pipetted out, and as a consequence,  larger 

amounts of HAs  dissolved into the buffer and were  carried over to the next step of the DNA 

isolation procedure.  

 

4.2.6.  SPIONS based inhibitor binding 

 

Direct lysis methods and sample pre-treatment procedures extracted high amounts of DNA 

but also HA whereas the indirect lysis method resulted in a much lower amount of DNA but 

also the smallest fraction of HAs (Table 5). Combining all two methods (i.e. direct lysis and 

sample-pre-treatment) together with the property of SPIONs to bind both HAs and DNA 

molecules, a new SPIONs based inhibitor binding protocol was created. 

The new extraction method successfully reduced amounts of HA by almost 90% when 

compared to the standard 16% PEG extraction (8% final PEG) (13.59 ng/µL as opposed to 

96.41 ng/µL, Table 5). Although, the total DNA yield suffered  50% decrease compared to the 

standard 16% PEG extraction,  amounts of  human  DNA were higher than in samples  

extracted using several other methods (e.g. direct lysis (10% and 15% PVP) and indirect lysis 

) allowing successful amplification of the 4-plex product with 1 in 10 DNA dilution.  
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4.2.7.  Optimisation of the SPIONs based inhibitor binding protocol- testing 

sample range and SPIONs amounts 

 

Further optimisation of the SPIONs based inhibitor binding DNA extraction protocol 

involved reduction of the amount of soil/body fluid sample as well as the amount of SPIONs  

used for DNA binding. This was carried out in order to find an optimum sample and SPION 

range for extraction of sufficient amounts of DNA with very low  HA content.  

As suspected, with increasing amount of the soil/semen mixture and SPIONs, DNA yield 

increased (Figure 5). However, in terms of HA, the relationship between sample amounts and 

SPION amounts was less obvious (Figure 6). A certain amount of variability is to be predicted 

in the binding of HA to SPIONs in the pre-lysis step where the presence of soil may interfere 

with HA binding.  

 

4.3.  PCR success 

 

The DNA extraction methods were also tested for their ability to recover PCR-ready human 

DNA using the Quantifiler® kit (Tables 5, 7).  

The commercial PowerSoil® kit was able to isolate high purity DNA therefore no sample 

dilution or increase in Taq  was neccessary to permit amplification of both the 4-plex and the 

bacterial 16S rDNA.  

Of all tested methods, the SPION based inhibitor binding method was the only technique that 

allowed successful amplification of the human and bacterial products when a 10 fold DNA 

dilution was performed (Tables 5, 6). Further optimisation of the SPIONs based inhibitor 

binding protocol  showed a decrease in DNA yield when less than 100 mg of the soil/semen 

mixture was used, with 5 mg resulting in undetectable amounts of human DNA and 

amplification of the 4-plex bands only after addition of extra Taq in the case of 20 µL 

SPIONs (Table 6). The bacterial product in contrast was present across all the sample range 
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and SPIONs amounts. The optimal amount seemed to be 125 mg of the soil/ semen mixture 

and 10 µL SPIONs since that was the only sample that amplified the 4-band product without 

the need of sample dilution. 

The amounts of HAs in the samples extracted using the direct lysis in the presence of 10% 

and 15% PVP and the indirect lysis were similar to SPION based inhibitor binding method. 

However, no 4-plex product was detected when PCR was performed on 10 fold dilution of the 

DNA. The fact that the bacterial 16S rDNA product was successfully amplified using the 

diluted DNA suggests an insufficient amount of the human DNA template being the cause of 

PCR failure, rather than PCR inhibition.  

Despite the fact that more total DNA  was detected in samples extracted without PEG in the 

binding buffer and no significant increase in HA content was detected, no amplification of the 

4-plex product occured even when 5U of Taq was used. In contrast a 3 band product was 

present when binding of DNA was performed in the presence of 16% PEG in the binding 

buffer. The presence of a high  amount of non-human DNA together with HA was most likely 

to be the cause of PCR failure in this case. However, the human to microbial DNA ratio was 

over 5 times lower in these samples compared to 0.11 in DNA extracted in the presence of 

PEG. Further  dilution of the samples extracted without PEG in order to bring the non-target 

DNA and HA content to a non-inhibitory level, would most likely result in insufficient 

amount of human  DNA. Thus, the binding buffer containing 16% PEG was used in all 

experiments.  

 

Furthermore, as mentioned previously, soils are very complex, heterogenous mixtures where 

their composition can vary between different types of soils (p. 14). Thus, it could be assumed 

that humic acids were not the only substances affecting the efficiency of PCR amplification. 

Variaty of substances, including different phenolic compounds, heavy metals, inorganic  salts, 



73 

 

ions or minerals are known to inhibit Taq polymerases. Thus, since the tolerance of both the 

PowerPlex 16® Human STR kit as well as the 4-plex and bacterial 16S rDNA PCR systems 

to humic acid was not determined, the conclusions as to what was the main cause of PCR 

failure were not clear.  According to the results of DNA quantification using the Quantifiler 

kit, there was a slight variation in Ct values between the DNA samples extracted  from the 

blood/soil and semen/soil mixtures despite the fact that the amounts of HAs detected in these 

samples were fairly similar (Table 6, 8). The observed differences in PCR efficiency were, 

most likely, caused by the presence of an additional inhibitory substance – heme. Therefore, 

identification of the exact minium inhibitory concentrations (MIC) for each system would 

have explained the reasons behind PCR failure to much higher extand – if the concentration of 

HA, in certain samples giving negative PCR results, was lower than the MIC for this 

inhibitor, it could be assumed that a third party inhibitor(s) were also present in the extracted 

DNA causing PCR failure.            

 

4.4.  DNA yield vs HAs co-extraction 

 

Regardless of the DNA extraction method used, a fraction of HAs has always been co-

extracted with the DNA. The commercial PowerSoil® kit was found to be most successful at 

removing HA where on average, the ratio of HA to total DNA was roughly 1:1 across the 

entire sample range. In addition, despite the fact that PowerSoil extracted less than half the 

amount of total DNA than that using  the SPION binding based isolation method, good 

quality DNA profiles were successfully generated.  

On average, HA content in the samples extracted with direct lysis approaches without the 

inhibitor binding step, was twice as high as the total DNA amount. DNA and HA could 

compete for the free binding sites on the surface of the magnetic beads where increased 

amount of one competitor may result in higher binding efficiency of that particular molecule. 



74 

 

Further modification of the SPION binding based DNA isolation protocol, where an inhibitor 

binding step was introduced, resulted in reduction of both the total DNA yield and HA 

content. Additionally, on average the ratio of HA to DNA was 2-4 times higher compared to 

other SPIONs binding based methods (e.g pre-lysis washing). The results could suggest that 

during the inhibitor binding step a larger fraction of DNA rather than HA was lost which 

resulted in higher overall binding efficiency of the inhibitor.  This loss of DNA as discussed 

above, was most likely due to poor retention of intact cells during the pre-lysis procedure. 

Similar to the SPION binding based DNA extraction, the commercial PrepFiler™ kit relies on 

the positive charge of the SPIONs which results in the binding of negatively charged DNA. 

However, in the case of DNA extraction from soil, PrepFiler™ also binds both the DNA and 

HA molecules. The initial quantification of HA content in DNA samples extracted using 

PrepFiler™ and the standard SPION based DNA binding protocol showed no significant 

difference in concentrations of HA (data not shown) (p>0.05, student T-test). The fact that, in 

terms of the volume of magnetic beads suspension, more SPIONs were used for DNA binding 

steps ( 20 µL and 15 µL for SPIONs and PrepFiler™ respectively) suggests that the affinity of 

HA to PrepFiler™ magnetic particles was much higher than to SPIONs magnetic beads or 

that the smaller size of the commercial beads resulted in much higher binding surface area 

therefore enabling HA to bind more efficiently.    

 

4.5.  DNA profiling 

 

4.5.1.  Human STR analysis of DNA extracted from soil/semen mixture 

 

DNA profiling performed on the range of sample and SPION amounts showed no significant 

difference in MLB values for (100, 125 and 250) mg of the semen/soil mixture in comparison 

to the profiles generated from DNA extracted from corresponding sample amounts using the 
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PowerSoil® kit (>0.05, one-way ANOVA). Although, higher HA content in SPION extracted 

DNA resulted in decreased TPH values in these samples suggesting lower PCR efficiency 

than that with PowerSoil® (Ct= 29.68, 27.87, respectively), the inhibition was not high 

enough to cause any peak imbalance (<0.4) or allele drop-outs. All peaks met the necessary 

rfu threshold of 50 for heterozygous and 100 for homozygous loci (refer to PowerPlex® 16 

manual). According to the PowerPlex® 16 manual  increasing the injection time could result 

in increased peak heights and therefore peak balance. Consequently this is something that 

could easily be applied in order to further improve the results using SPIONs. The  presence of 

allele drop-outs is the most crucial characteristic used in judging the quality of DNA profiles 

generated (Hedman et al. 2009) but none were observed in the DNA profiles generated from 

PowerSoil® and SPIONs inhibitor binding based extracted DNA when (100-250) mg of the 

mixture and all three SPIONs amounts were used. Highly imbalanced profiles could 

potentially mislead the analyst of what was a true peak, stutter or an artefact (Hedman et al. 

2010). Moreover, profile imbalance in conjunction with allele drop-outs could make a 

particular DNA profile completely unreadable (Hedman et al. 2010). Thus, the profiles 

generated using DNA extracted with PowerSoil® and SPIONs based inhibitor binding  

protocol in this study were of good quality with none of these issues despite consistently 

lower overall TPH values with SPIONs.  

 

4.5.2.  Human STR analysis of DNA extracted from soil/blood mixture 

 

In the case of blood contaminated soil, when the optimised SPION extraction was used to 

perform DNA isolation, total DNA yield did not exceed 5 ng/µL. In addition, over 50% less 

target DNA was present in the samples extracted using SPION than those with the 

PowerSoil® kit (Table 8).  
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In addition, DNA profiling was successful only when DNA extracted from 250 mg of the 

blood/soil mixture using 20 µL SPIONs was used. Although no allele drop-out occurred, the 

MLB suffered a significant decrease in comparison to the profiles generated using the 

PowerSoil® kit (Figure 10) (Ct=30.97, 27.64, respectively). In addition, the observed increase 

in Ct values, compared to DNA extracted from the semen/soil mixture, was most likely due to 

the presence of heme which together with HAs and reduced DNA yield casued PCR failure 

and decrease in TPH and MLB.  Furthermore, full profiles were obtained from DNA extracted 

from the entire sample range using PowerSoil®. This difference in performance of the new 

SPION based extraction method was most likely caused by the fact that semen contains much 

more DNA. In addition sperm cells are  much more resistant to mechanical damage that may 

be caused by the pre-lysis SPION binding procedure therefore retaining  DNA within intact 

cells rather than loss of DNA from binding to the magnetic beads used for the inhibitor 

binding step. 
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5.  Conclusions and future work 
 

 

This study showed that extraction of DNA of good quality and purity from body fluid 

contaminated soil samples is particularly difficult due to co-extraction of HAs. Even some 

commercial DNA purification kits PrepFiler™ Forensic DNA isolation kit are incapable of 

extracting DNA of good quality from body fluid contaminated soil. Others, such as 

PowerSoil®, are highly effective in removing PCR inhibitors but the amounts of total DNA 

recovered are low. In addition, the PowerSoil® method often involve several centrifugation 

and sample re-pipetting steps that are time consuming and could potentially cause 

contamination.  

In this study, an alternative method of extracting DNA using SPIONs has been developed. 

Although the amounts of HA present in isolated DNA using SPIONs were higher than in 

PowerSoil®-purified DNA, the method was able to extract at least twice as much DNA for a 

fraction of the cost (<£1 as opposed to £3.50 per sample). Although overall PCR efficiency 

was higher when Powersoil®-extracted DNA was used since TPH values were consistently 

higher, it was  also demonstrated that the quality of Powerplex® 16 DNA profiles generated 

from DNA extracted using both DNA extraction methods were equally good with respects to 

allele scoring when sample amounts ranged from 100 to 250 mg were compared. 

Therefore, the SPION based DNA extraction successfully isolated high amounts of good 

quality pure DNA from semen contaminated soil samples but additional work on optimisation 

of the purification protocol is required in order to further reduce the amount of HA co-

extracted.  

In addition, the SPION inhibitor binding step should ideally be replaced by more efficient 

DNA purification technique that would allow extraction of nucleic acids from degraded or 

more sensitive to mechanical damage samples.  
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Modification of the SPIONs surface to selectively bind target DNA alone (and not HA)  

would be the most advantageous method of purification reducing PCR inhibition and the 

sample processing time. 

Moreover, much more detailed analysis of the inhibitors present in the extracted DNA 

samples should also be performed to determine the contribution of each inhibitor to PCR 

failure which could then be used in further optimisation experiments. It should involve 

physical and chemical testing of soil samples and DNA extracts to determine their exact 

composition as well as inhibitor spiking experiments (pure DNA spiked with known 

concentrations of tested inhibitors) to identify the minimum inhibitory concentration for each 

inhibitor tested. In addition, different types of soils should also be tested in order to fully 

understand how their chemical and organic composition affects the purity of extracted DNA.
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6.  Appendix 
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Appendix 1 

SPIONs binding based standard DNA extraction PROTOCOL 1 

 

1. 460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 

Eppendorf tubes containing the sample and vortexed for 5 sec at maximum speed. 

2. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

3. The supernatant was transfered to a new 1.5 mL tube containing 500 µL of the binding 

buffer (20% PEG 4 M NaCl) and 20 µl of 8.86 mg/mL SPIONs (pre-washed twice in 

20mM Tris buffer pH=8.0). 

4. DNA binding was carried out for 5 min inverting the samples several times. 

5. Magnetic beads were immobilised by placing the samples on a magnetic stand. 

6. The supernatant was then discarded. 

7. After removing the samples from magnetic stand 300 µL of 70% ethanol was added 

and mixed well by inverting 20 times. 

8. The samples were then placed back on a magnetic stand to immobilise the magnetic 

beads and supernatant discarded.  

9. Steps 8 and 9 were repeated three times. 

10. SPIONs were air-dried at room temperature for no longer than 20 min.  

11. DNA elution step was carried out in 100 µL of 1x TE buffer for 10 min. 

12. DNA was stored at -20 °C. 

 

 

 

 



81 

 

Appendix 2 

SPIONs binding based DNA extraction MODIFICATION 1 

 

1. 460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 1.5 

mL Eppendorf tubes containing the sample and vortexed for 5 seconds at maximum 

speed. 

2. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

3. Supernatant was transfered to a new 1.5 mL Eppendorf tube and placed on ice for 10 

minutes.  Samples were then centrifuged at 13000 rpm for 2 min. 

4. Supernatant was transfered to a new 1.5 mL tube containing 500 µL of the binding 

buffer (20% PEG 4 M NaCl) and 20 µl of 8.86 mg/mL SPIONs (pre-washed twice in 

20mM Tris buffer pH=8.0). 

5. DNA binding was carried out for 5 min inverting the samples several times. 

6. Magnetic beads were immobilised by placing the samples on a magnetic stand. 

7. The supernatant was then discarded. 

8. After removing the samples from magnetic stand 300 µL of 70% ethanol was added 

and mixed well by inverting 20 times. 

9. The samples were then placed back on a magnetic stand to immobilise the magnetic 

beads and supernatant discarded.  

10. Steps 8 and 9 were repeated three times. 

11. SPIONs were air-dried at room temperature for no longer than 20 min.  

12. DNA elution step was carried out in 100 µL of 1x TE buffer for 10 min. 

13. DNA was stored at -20 °C. 
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Appendix 3 

SPIONs binding based DNA extraction MODIFICATION 3 

 

1. 460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 1.5 

mL Eppendorf tubes containing the sample and vortexed for 5 seconds at maximum 

speed. 

2. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

3. Supernatant was transfered to a new 1.5 mL Eppendorf tube and placed on ice for 10 

minutes.  Samples were then centrifuged at 13000 rpm for 2 min. 

4. Supernatant was transfered to a new 1.5 mL tube containing 500 µL of the binding 

buffer (16% PEG 4 M NaCl) and 20 µL of 8.86 mg/mL SPIONs (pre-washed twice in 

20mM Tris buffer pH=8.0). 

5. DNA binding was carried out for 5 min inverting the samples several times. 

6. Magnetic beads were immobilised by placing the samples on a magnetic stand. 

7. The supernatant was then discarded. 

8. After removing the samples from magnetic stand 300 µL of 70% ethanol was added 

and mixed well by inverting 20 times. 

9. The samples were then placed back on a magnetic stand to immobilise the magnetic 

beads and supernatant discarded.  

10. Steps 8 and 9 were repeated three times. 

11. SPIONs were air-dried at room temperature for no longer than 20 min.  

12. DNA elution step was carried out in 100 µL of 1x TE buffer for 10 min. 

13. DNA was stored at -20 °C. 
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Appendix 4 

SPIONs binding based DNA extraction MODIFICATION 5 

 

1. Into each tube containing the soil/semen mixture 500 µL of 20 mM Tris buffer was 

added and vortexed 5 times for 15 sec at low speed. 

2. The samples were then centrifuged at 1000 rpm for 5 min and the supernatant 

discarded. 

3. Steps 1 and 2 were repeated twice. 

4. 460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 1.5 

mL Eppendorf tubes containing the sample and vortexed for 5 sec at maximum speed. 

5. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

6. Supernatant was transfered to a new 1.5 mL Eppendorf tube and placed on ice for 10 

min.  Samples were then centrifuged at 13000 rpm for 2 min. 

7. Supernatant was transfered to a new 1.5 mL tube containing 500 µL of the binding 

buffer (20% PEG 4 M NaCl) and 20 µL of 8.86 mg/mL SPIONs (pre-washed twice in 

20mM Tris buffer pH=8.0). 

8. DNA binding was carried out for 5 min inverting the samples several times. 

9. Magnetic beads were immobilised by placing the samples on a magnetic stand. 

10. The supernatant was then discarded. 

11. After removing the samples from magnetic stand 300 µL of 70% ethanol was added 

and mixed well by inverting 20 times. 

12. The samples were then placed back on a magnetic stand to immobilise the magnetic 

beads and supernatant discarded.  

13. Steps 8 and 9 were repeated three times. 

14. SPIONs were air-dried at room temperature for no longer than 20 min.  

15. DNA elution step was carried out in 100 µL of 1x TE buffer for 10 min. 

16. DNA was stored at -20 °C. 
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Appendix 5 

SPIONs binding based DNA extraction MODIFICATION 7 

 

1. Into each tube containing the soil/semen mixture 400 µL of 4 M NaCl and 20 µL 

SPIONs were added. The samples were then placed on a flat-platform shaker and 

incubated for 10 min at 600rpm. 

2. Using a magnetic stand and blue p1000 tips most of the supernatant and the sample 

were transferred to a new tube. 

3. Steps 1 and 2 were repeated twice.  

4. 460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 1.5 

mL Eppendorf tubes containing the sample and vortexed for 5 sec at maximum speed. 

5. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

6. Supernatant was transfered to a new 1.5 mL Eppendorf tube and placed on ice for 10 

min.  Samples were then centrifuged at 13000 rpm for 2 min. 

7. Supernatant was transfered to a new 1.5 mL tube containing 500 µL of the binding 

buffer (16% PEG 4 M NaCl) and 20 µL of 8.86 mg/mL SPIONs (pre-washed twice in 

20mM Tris buffer pH=8.0). 

8. DNA binding was carried out for 5 min inverting the samples several times. 

9. Magnetic beads were immobilised by placing the samples on a magnetic stand. 

10. The supernatant was then discarded. 

11. After removing the samples from magnetic stand 300 µL of 70% ethanol was added 

and mixed well by inverting 20 times. 

12. The samples were then placed back on a magnetic stand to immobilise the magnetic 

beads and supernatant discarded.  

13. Steps 8 and 9 were repeated three times. 

14. SPIONs were air-dried at room temperature for no longer than 20 min.  

15. DNA elution step was carried out in 100 µL of 1x TE buffer for 10 min. 

16. DNA was stored at -20 °C. 
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Appendix 6 

Phenol/chloroform DNA isolation PROTOCOL 

 

1.  460 µL of the X2 lysis buffer, 20 µL DTT and 20 µL Proteinase K were added to 1.5 

mL Eppendorf tubes containing the sample and vortexed for 5 sec at maximum speed. 

2. Samples were incubated at 56 °C for an hour, vortexing every 15 min and then 

centrifuged at 13000 rpm for 2 min. 

3. 250 µL of the supernatant was transferred into a new tube containing 250 µL 

phenol/chloroform and mixed by vortexing for 10 sec at maximum speed. 

4. Samples were then centrifuged at 13000 rpm for 2 min. 

5. Steps 3 and 4 were repeated twice. 

6. The supernatant was transferred into a new tube containing 0.6 volumes of 

isopropanol and 0.1 volumes of 3 M NaAc, and vortexed for 10 sec at maximum 

speed. 

7. Samples were centrifuged at 13000 rpm for 10 min and supernatant discarded.  

8. 250 µL of 70% ethanol was added to each tube, vortexed and then centrifuged at 

13000 rpm for 3 min. 

9. Supernatant was discarded and pellets were allowed to air-dry for no longer than 20 

min. 

10.  100 µL AE buffer was used to elute the DNA. 
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Appendix 7 

PowerSoil® DNA isolation PROTOCOL (MOBio Laboratories, Inc.) 
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Appendix 8 

 

PrepFiler ™ Forensic DNA isolation kit (Applied Biosystems) 
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Appendix 9 

Quantifiler® Human DNA quantification kit PROTOCOL (Applied Biosystems) 

 

Preparation of DNA standards dilution series: 
 
 

1. Label eight sterile eppendorf tubes and Std 1 – Std 8. 
 
 
 
2. Dispense 30 µl of sdH2O into Std tube 1 and 20 µl into each of the remaining 

tubes (Std 2 – Std 8). 
 
 

3. Preparation of Std 1: 
 

a. Thaw the Quantifiler Human DNA Standards and vortex to ensure it is 
thoroughly mixed. 

b. Add 10 µl of Quantifiler Human DNA to Std tube 1. 
c. Mix thoroughly. 

 
 

4. Preparation of Std 2 – Std 8: 
 

a. Remove 10 µl from Std 1 and add to Std tube 2. 
b. Mix thoroughly. 
c. Remove 10 µl from Std 2 and add to Std tube 3. 
d. Mix thoroughly. 

 
 
 
Repeat steps 4c and 4d for the remained of the dilution series. 
 
 
 
Concentration of DNA Standards: 
 

 Std 1 Std 2 Std 3 Std 4 Std 5 Std 6 Std 7 Std 8 

ng/µl 50 16.7 5.56 1.85 0.62 0.21 0.07 0.02 
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Real-Time PCR Protocol :  
 
 
Step 1: Preparation of DNA samples. 
 
 

1. Calculate the required volume for each component (i.e. multiply the volume 
below by the number of samples). 

 

               Component Volume per 
Reaction (µl) 

Volume for ___ 
reactions 

Quantifiler Human 
Primer Mix  

5.25  

Quantifiler PCR 
Reaction Mix 

6.25  

 
 
2. In a sterile eppendorf tube make up a master mix of the above components for 

all your reactions. 
 
3. Place a 96 well optical plate in its holder – this is important to prevent 

contamination of the base of the plate which may affect the results. 
 

4. Pipette 11.5 µl of the master mix into each plate well. 
 

5. Using a new sterile tip each time add 1 µl of sample/standard to the aliquoted 
master mix. NOTE: set standards in duplicate. 

 
6. Ensure there are no air bubbles at the bottom of your tubes and that all liquid 

is at the bottom of the tube. 
 

7. Place the optical adhesive cover on the 96 well plate. Make sure that the cover 
is securely adhered to the wells. The plate is ready to be placed in the 
machine. 

 
8. Load the optical plate into the 7500  (NOTE: well A1 should be in the top left 

corner). 
  
 
 
Step 2: RealTime-7500 Set up 
 

1. Start the 7500 Software System. 
 
2. Select > FILE > NEW 

 
You should see a New Document Wizard: 
 

Assay = Absolute Quantification (Standard Curve). 
Container = 96 Well – Clear. 
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Template = Blank Document. 
  
 Give your plate a name. 
 

1. Select > NEXT. 
 
2. Select the appropriate detector(s) 

 
IPC = VIC 
Quantifiler Human Kit = FAM 

  
 Click > ADD 
 

3. Select > NEXT. 
 
4. Specify the wells and that you are going to use and which detectors are to be 

used for each well. 
 

a. Highlight the wells. 
b. Click USE for each detector. 
c. Under the TASK select whether the sample is a Standard or an 

Unknown. 
d. If a Standard enter the Quantity as appropriate. 
  

5. Select > FINISH. 
 

6. You should now see a plate setup, there are several tabs: 
 

a. Setup Tab – shows you your plate. 
b. Instrument Tab – Shows the cycling parameters (can be edited if 

required) – set the reaction volume 
 
We will use the default Cycling parameters: 
 
95°C 10 min 
95°C 15 sec 
60°C   1 min 

 
c. Results Tab – will detail the results of your analysis. 

 
7. In the Setup Tab 
 

a. Double click on a well – this will open the well inspector. 
b. Enter your sample names into each appropriate well 

 
Detectors, Tasks and Quantities can be edited at this point if required. 
 

8.  Select > CLOSE. 
3. Select > FILE > SAVE AS and save your file. 
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4.  Select > START  
 

 
 
Step 3: Analysis of results: 
 

1. Open 7500 Software System. 
 
2. Select > FILE > OPEN > find your file. 

 
3. You should now see a plate setup with several tabs: 

 
a. Setup Tab – shows you your plate. 
b. Instrument Tab – Shows the cycling parameters. 
c. Results Tab – will detail the results of your analysis. 

 
4. Select  to analyse your data. 

 
5. Select the Results Tab. Within the results tab are many other tabs: 

 
a. Plate – shows your plate set up. 
b. Spectra – shows the raw data (all wells at once). 
c. Component – can select data from single wells. 
d. Amplification plot – can show your data as single wells or selected wells 

in either log or linear view. 
e. Standard Curve – shows the results from the standards against which 

you unknown samples will have been quantified. 
f. Report  - shows the quantification results from your samples. 
 

6. Select FILE > EXPORT allows you to export your results data in Excel format.   
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Appendix 10 

PowerPlex 16® Human STR kit PROTOCOL (Promega) 

 

Step 1- PowerPlex 16 PCR Set up: 
 
 
    per reaction   
Buffer Mix   2.5 µl   
Primer Mix   2.5 µl    
Amplitaq GOLD   0.8 µl      
H2O            19.2 µl           
DNA    1.00 µl 
 
 
PowerPlex 16 PCR Cycling Parameters: 
 
 

Initial denaturation:   95C 11 mins  

    96C 1 min 
 

Denaturation:  94C 30 sec 100% ramp 

Annealing:   60C 30 sec 29% ramp      for 10 cycles 

Extension:   70C 45 sec 23% ramp 
 

Denaturation:  90C 30 sec 100% ramp 

Annealing:   60C 30 sec 29% ramp            for 22 cycles 

Extension:   70C 45 sec 23% ramp 
 

Final Extension:  60C 30 mins 
 

Hold:    4C  
 
 

Step 2 – Sample Preparation  
 

7. For each sample you will require 10 µl Formamide + 0.5 µl ILS600 size 
standard. Make up a master mix sufficient for all samples 

 
8. Aliquot 10.5 µl of master mix into 0.2 ml eppendorf tubes and add 1 µl of PCR 

sample or Allelic Ladder 
 

9. Denature, vortex to mix and spin 
 

10. Remove the lid and set tubes in tray with septa and lid 
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Step 3 – Preparing the PowerPlex16 Run 
 

11. Go to Window>Manual Control>Temperature Set>Set at 60C then execute 
 

12. Go to File> New, Select Genescan Sample Sheet 96 
 

13. Add you sample names into the appropriate wells 
 

14. Cut and Paste data into the Sample Info column 
 

15. Save As>FILENAME and close 
 

16. Go to File>New>Genescan Injection List and find your sample sheet 
 

17. Make sure settings are correct: 
 

- Module = GS STR POP4 (A) 
- Injection = 5 
- Run Time = 32 min 

 
 

18. Run 
 
 
 

Step 4 – Genemapper 
 
 

19. Open Genemapper 
 

20. Go to File>Add Samples to Project 
 

21. Find data, Computer>D:>AppliedBio>3.0>Runs>find file by DATE 
 

22. Add to list 
 

23. Check that settings are correct 
 

- Sample type = either ‘Sample’ or ‘Allelic Ladder’ 
- Analysis Method = e.g. microsatellite default 
- Panel = chose appropriate multiplex kit if appropriate (Powerplex 16) 
- Size = chose the correct size standard (ILS600) 

 - Matrix = as appropriate (Powerplex16) 
 

24. Save As>FILENAME 
 

25. Analyse 
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Appendix 11 

4-plex PCR set up PROTOCOL 

Background information: 

4-plex is an in-house developed PCR multiplex amplifying four different fragments including 

70 bp, 194 bp, 305 bp and 384 bp fragments in a single closed-tube reaction format. The 

amplification protocol have been optimized and successfully used to assess effects of tissue 

degradation on PCR  efficiency in humans, rabbits and pigs (Nazir et al. 2013). Note that the 

4-plex is not a STR type of multiplexes therefore cannot be used for individualization. 

 

Total volume of the Primer Mix (20 µL) = 7.5 µL of the 4-plex primers mix (A + B + C + 

D) + 12.5 µL  H2O 

 

Primer set Amplicon length 
Final conc. in the 

Primer mix 
Volume from 100 µL stock 

A 70bp 0.1 µM 
0.5 µL F 
0.5 µL R 

B 194bp 0.1 µM 
0.5 µL F 
0.5 µL R 

C 305bp 0.15 µM 
0.75 µL F 
0.75 µL R 

D 384bp 0.4 µM 
2 µL F 
2 µL R 

 TOTAL  7.5 µL 

 

 

AmpliGOLD MASTER MIX 

 

REAGENT  VOLUME  

10x buffer  1.5 µL 

MgCl2(25mM) 1.5 µL 

dNTP(25mM)  0.12 µL 

Primer Mix  0.6 µL  x NO. reactions 

TaqGold  0.1 µL 

H2O   10.18 µL 

DNA   1 µL 

TOTAL  15 µL 

 

 

 

 

PCR CYCLIN CONDITIONS 

95 °C 5mins 

94 °C 1min 

60 °C 1min  30 cycles 

72 °C 1min 

72 °C 20mins 
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Appendix 12 

Bacterial 16S rDNA PCR set up PROTOCOL 

Background information 

Primers targeting a single 16S rDNA fragment of 566 bp were used in this thesis as a DNA 

extraction control method to ensure that any given PCR failure was not caused by lack of 

DNA template.  

Primers used: 

F-341 5’-CCTACGGGAGGCAGCAG 

R-907 5’-CCGTCAATTCMTTTGAGTTT  

 

AmpliGOLD MASTER MIX 

 

REAGENT  VOLUME  

10x buffer  1.5 µL 

MgCl2(25mM) 1.5 µL 

dNTP(25mM)  0.12 µL             x NO. reactions 

Primer Forward          0.03µL 

Promer Reverse 0.03 µL   

TaqGold  0.1 µL 

H2O   10.18 µL 

DNA   1 µL 

TOTAL  15 µL 

 

 

 

 

PCR CYCLIN CONDITIONS 

95 °C 5mins 

95 °C 0.5min 

60 °C 0.5min  30 cycles 

72 °C 0.5min 

72 °C 20mins 
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Appendix 13 

X2 Lysis Buffer 

 

EDTA (ph=8.0)  20 mM 

Tris-HCL     20 mM 

NaCl      1.0 M 

SDS      2% 

DTT      80 mM 

Proteinase K     400 µg 

 

 

Note: For 15% and 10% PVP X2 lysis buffers, 15 and 10 g of PVP were added to 100 mL of 

the X2 lysis buffer, respectively.  

 

 

 

 

 

 

 

 

 

 

 

 



102 

 

Appendix 14 

 

 

 

 

 

 

 

 

Figure 11. STR profile using DNA extracted from 25mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 15 

 

 

 

 

 

 

 

 

Figure 12. STR profile using DNA extracted from 25mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 6 of the 16 loci are shown. 
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Appendix 16 

 

 

 

 

 

 

 

 

Figure 13. STR profile using DNA extracted from 25mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 17 

 

 

 

 

 

 

 

 

Figure 14. STR profile using DNA extracted from 50mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 18 

 

 

 

 

 

 

 

 

 

Figure 15. STR profile using DNA extracted from 50mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 6 of the 16 loci are shown. 
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Appendix 19 

 

 

 

 

 

 

 

 

Figure 16. STR profile using DNA extracted from 50mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 20 

 

 

 

 

 

 

 

 

Figure 17. STR profile using DNA extracted from 100mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 21 

 

 

 

 

 

 

 

 

Figure 18. STR profile using DNA extracted from 100mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 6 of the 16 loci are shown. 
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Appendix 22 

 

 

 

 

 

 

 

 

Figure 19. STR profile using DNA extracted from 100mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 23 

 

 

 

 

 

 

 

 

Figure 20. STR profile using DNA extracted from 125mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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Appendix 24 

 

 

 

 

 

 

 

Figure 21. STR profile using DNA extracted from 125mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 6 of the 16 loci are shown. 
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Appendix 25 

 

 

 

 

 

 

 

 

Figure 22. STR profile using DNA extracted from 125mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 

 



114 

 

Appendix 26 

 

 

 

 

 

 

 

 

Figure 23. STR profile using DNA extracted from 250mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 

 



115 

 

Appendix 27 

 

 

 

 

 

 

 

Figure 24. STR profile using DNA extracted from 250mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 6 of the 16 loci are shown. 
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Appendix 28 

 

 

 

 

 

 

 

Figure 25. STR profile using DNA extracted from 250mg of the soil/semen mixture using 

PowerSoil (A) and SPION binding (three different amounts of magnetic beads i.e 20µL (B), 

10µL (C) and 5µL (D) were used for the DNA binding step. 

Note: only 5 of the 16 loci are shown. 
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